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1.	 Einführung
Wir danken Ihnen für den Kauf des Acoustilyzer AL1, einem speziell für 
professionelle akustische Testanwendungen entwickelten Produkt. Der 
Acoustilyzer AL1 bietet umfangreiche akustische Messfunktionen, ein 
optionales STI-PA Sprachverständlichkeitsmodul sowie weiteren einfachen 
elektrischen Messungen. Viel Spass bei der Benützung des Acoustilyzer 
AL1.

Dieses Handbuch beschreibt im Detail die Messfunktionen des Acoustilyzer 
AL1. Zusätzliche Informationen über akustische und elektrische 
Audiomessungen finden Sie auf der Webseite „www.nti-audio.com”.

Der Acoustilyzer AL1 ist als Einzelmessgerät oder in Form einer Crossgrade 
Firmware für alle Minilyzer ML1 Anwender erhältlich. Dasselbe Crossgrade-
Paket kann auch zur Installation der Minilyzer Firmware auf dem AL1 
verwendet werden. Die STI-PA Sprachverständlichkeits-Messfunktion ist 
optional.

Die verschiedenen Produkteinheiten inkludieren die folgenden Positionen:

Acoustilyzer AL1 1x	Acoustilyzer AL1
1x	MiniLINK CD (PC Software)
1x	MiniLINK USB Kabel
1x	Acoustilyzer Test CD 
1x	Acoustilyzer Handbuch

ML1-AL1 Crossgrade 1x	MiniLINK CD (PC Software)
1x	Acoustilyzer Test CD
1x Lizenznummer Crossgrade
1x	Acoustilyzer Handbuch
1x	Minilyzer Handbuch

STI-PA Messoption 1x	STI-PA Test CD (STI-PA Test Signal)
1x Lizenznummer STI-PA
1x	Acoustilyzer Handbuch

www.nti-audio.com
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Registrierung

Registrieren Sie sich als NTi Audio Kunde und profitieren Sie von den 
folgenden Möglichkeiten:

•	 Aktualisieren Sie Ihre Produkte 
Kostenlose Firmware- und Software-Updates. 

•	 Aktivieren Sie Optionen 
Erweitern Sie Ihr Produkte mit zusätzlichen Funktionen.

•	 Freier Zugriff auf Service-Webseiten 
Erlangen Sie Zugriff zu Downloads, Informationen und speziellen 
Services zu Ihren Produkten. 

•	 Erhalten Sie Anwendungs- und Produktneuigkeiten 
Melden Sie sich zum NTi Audio Newsletter an. 

•	 Schneller weltweiter Service 
Registrieren Sie Ihre Produkte für einen schnellen Service. 

•	 Bestätigen Sie den Besitz Ihres Produktes 
Ermöglicht es uns bei wichtigen Verbesserungen Sie zu kontaktieren 
und belegt den Besitz bei Verlust oder Diebstahl.

Anleitung zur Registration

•	 Öffnen Sie die Webseite „http://my.nti-audio.com“.

•	 Melden Sie sich an oder erstellen Ihr My NTi Audio Konto.

•	 Die Webseite „Meine NTi Audio Produkte“ wird geöffnet.

•	 Wählen Sie das entsprechende Produkt aus und geben die Seriennummer 
ein 

•	 Klicken Sie auf das Feld „Registrierung“. 

•	 Nun ist das Produkt bei „Meine NTi Audio Produkte“ aufgelistet. 
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Konformitätserklärung

Wir, der Hersteller NTi Audio AG, Im alten Riet 102, 9494 Schaan, 
Liechtenstein, deklarieren hiermit, dass das Produkt Acoustilyzer AL1 mit 
den folgenden Standards oder anderen normativen Dokumente entspricht:

•	 EMC: 2004/108/EG

•	 Harmonisierte Standards EN 61326-1

•	 Explosionsgefährdete Bereiche (ATEX): 94/9/EG

•	 Direktive 2011/65/EU zur Beschränkung der Verwendung bestimmter 
gefährlicher Stoffe in Elektro- und Elektronikgeräten (RoHS).

•	 Direktive 2002/96/EU zur Reduktion der zunehmenden Menge an 
Elektronikschrott (WEEE).

Diese Deklaration wird ungültig, sobald ohne schriftliche Genehmigung von 
NTi Audio irgendwelche Änderungen am Gerät vorgenommen werden.

Datum:					     1. September 2013

Unterschrift:			

Position:					     Technischer Direktor
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Internationale Garantie und Reparatur

Internationale Garantie
NTi Audio garantiert die einwandfreie Funktion des Acoustilyzer AL1 für ein 
Jahr ab dem Verkaufsdatum. In dieser Periode werden defekte Acoustilyzer 
AL1 kostenlos repariert oder ausgetauscht.

Einschränkungen
Diese Garantiebestimmung erstrecken sich nicht auf Schäden, die durch 
Unfälle, Transport, falsche Verwendung, Unachtsamkeit, durch Zubehör 
bzw. Einbau von Teilen die nicht zum Gerät geliefert wurden, den Verlust von 
Teilen, den Anschluss an Netzspannung, den Betrieb mit nicht spezifizierten 
Eingangsspannungen, Adaptertypen oder falsch eingelegte Batterien 
verursacht wurden. Im speziellen lehnt NTi Audio jegliche Verantwortung 
für Folgeschäden ab.

Die Garantie verfällt bei der Durchführung von Reparaturen oder 
Wartung durch Dritte, die nicht Teil eines bevollmächtigten NTi Audio 
Wartungszentrums sind.

Reparatur
Im Falle einer Fehlfunktion oder eines Schadens, senden Sie den NTi Audio 
Acoustilyzer AL1, verpackt in der Originalschachtel, zu Ihrer nächsten 
NTi Audio Vertretung. Bitte legen Sie eine genaue Fehlerbeschreibung 
bei. Die Kontaktadressen finden Sie auf der NTi Audio Webseite  
„www.nti-audio.com”

Garantiereparaturen bzw. -austausch werden nur gegen Vorlage des  
Originalverkaufsbelegs durchgeführt.

www.nt-instruments.com
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Wichtige Hinweise

Um Problemen bei der Anwendung des Gerätes vorzubeugen, beachten 
Sie bitte folgende Punkte:

•	 Benützen Sie den AL1 nur für den vorgesehenen Zweck.

•	 Schliessen Sie den AL1 nie direkt an eine Leistungsausgang 
wie z.B. Verstärkerausgang, Netzanschluss etc. Die maximale 
Messspannung beträgt 20 dBu (22 Vpp) .

•	 Der Acoustilyzer AL1 darf nicht geöffnet und zerlegt werden.

•	 Verwenden Sie den AL1 nie in nasser Umgebung.

•	 Entfernen Sie die Batterien, sobald sie leer sind, oder falls Sie 
den AL1 für längere Zeit nicht benutzen.

Test & Kalibrierzertifikat

Hiermit wird bestätigt, dass der Acoustilyzer AL1 nach der Produktion 
komplett getestet wurde und den Produktspezifikationen des Herstellers 
entspricht. NTi Audio empfiehlt, das Messgerät in jährlichen Intervallen zu 
kalibrieren.
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2.	 Übersicht
Der Acoustilyzer AL1 ist ein hochwerti-
ges Werkzeug zur Analyse akustischer 
Signale. Zudem können auch die 
wichtigsten elektrischen Parameter be-
stimmt werden. Die exakten Resultate 
werden auf einer grossen LCD Anzeige 
dargestellt. 

Akustisches Messgerät Klasse 2
Der Acoustilyzer ist in Verbindung 
mit dem MiniSPL ein umfangreiches 
akustisches Klasse 2 Messgerät. Das 
MiniSPL ist als batteriebetriebenes 
Messmikrofon das ideale Zubehör für 
den Acoustilyzer.

Akustisches Messgerät Klasse 1
Der Acoustilyzer zusammen mit dem 
NTi Audio Messmikrofon M2010 bildet 
ein hochwertiges Klasse 1 Messgerät, 
wobei für das M2010 eine externe 
Phantomspeisung benötigt wird. 
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Acoustilyzer Messfunktionen

Die zahlreichen Messfunktionen lassen sich 
über ein „drop down Menü“ auswählen.

Das Hauptelement bei der Bedienung ist 
der Cursor (invertiertes Feld), der mittels 
Tastatur durch die verfügbaren Funktionen 
navigiert wird.

• SPL/RTA:	 Messung des aktuellen und des durchschnittlichen, 
integrierten Schalldruckpegels (LEQ) in Breitband, 1/1 
Oktav- oder 1/3 Oktavbandauflösung

• RT60:	 Nachhallzeit mit 1/1 Oktavbandauflösung

• FFT:	 Echtzeit Zoom FFT

• POLARITY:	 Polaritätsmessung von Lautsprechern und elektrischen 
Signalen

• DELAY:	 Akustische Laufzeitmessung (Delay Zeit Messung)

• RMS/THD:	 Pegel- und Verzerrungsmessung

• STI-PA:	 Sprachverständlichkeitsmessung (diese Funktion ist 
nur nach Aktivierung der STI-PA Option verfügbar)

• CALIBRTE:	 Kalibrierung des angeschlossenen Messmikrofons

Einfache Bedienung

Mit Cursor selektiertes Feld 
zur Auswahländerung

Alle wählbaren Einstellungen lassen sich 
sehr einfach ändern:
•	 Cursors auf die fragliche Einstellung 

platzieren und Enter-Taste drücken,
•	 Änderung der Einstellung mittels der 

Pfeil- oder Enter Taste,
•	 Ggf. Bestätigung mit der Enter-Taste.
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Eingänge & Monitorausgang

Am oberen Ende des AL1 befinden sich drei Ein-/Ausgangsstecker sowie 
ein Mikrofon:

•	 Je ein XLR und RCA Eingang. Für beste Messergebnisse  empfehlen 
wir die Verwendung des XLR-Eingangs (minimales Grundrauschen 
und bester Dynamikbereich). Falls ein unsymmetrisches 
Messmikrofon verwendet wird, soll dieses auch am XLR-Eingang, 
zwischen Pin 2 und 3, angeschlossen werden.

•	 Ein 3.5 mm (1/8“) Klinkenstecker ermöglicht den Anschluss eines 
Kopfhörers, über den sich das Eingangssignal abhören lässt.

•	 Ein internes Mikrofon für Polaritätstests und Laufzeitmessungen.

XLR & RCA 
Eingang

Monitor 
Ausgang

Internes 
Mikrofon

Achtung:	Verbinden Sie nie gleichzeitig den XLR und RCA Eingang.
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Einsetzen der Batterien

Nach dem Auspacken setzen Sie bitte 3 Stk. 1.5 V Alkali Batterien vom 
Typ AA (LR6, AM3) wie unten dargestellt ins Batteriefach ein. Die typische 
Betriebsdauer des AL1 mit frischen Alkali Batterien beträgt 16 Stunden.

         

Hinweise:

•	 Bei der Verwendung von NiCd oder NiMH Akkumulatoren 
verkürzt sich die spezifizierte Betriebsdauer.

•	 Setzen Sie keine unterschiedlichen Batterietypen zur gleichen 
Zeit ein.

•	 Wechseln sie immer alle Batterien - mischen Sie nie alte und 
neue Batterien.

•	 Achten Sie beim Einsetzen der Batterien auf die korrekte 
Polarität.

•	 Entfernen Sie leere Batterien sofort und wechseln Sie alle 
Batterien gleichzeitig.
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3.	 Grundfunktionen
Trotz der grossen Anzahl von Messfunktionen und verfügbaren 
Zusatzeinstellungen ist die Anwendung des Acoustilyzer sehr einfach.

Menüleiste

Testresultat

Gerät ein/aus, 
LCD Beleuchtung

Escape 
Taste

Enter / Cursor 
Tasten

Das LCD ist in zwei Bereiche unterteilt: Die Menüleiste und die darunter 
liegende Resultatanzeige.

Die Cursortasten und die „ESC“ Taste erlauben die Anwahl und Anzeige 
der verfügbaren Funktionen bzw. Informationen:

•	 Momentanzustand (Messfunktion, Filter)

•	 Messresultate (numerische Werte & grafische Anzeige)
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Startanzeige

Wird beim Erscheinen des Startbildschirms 
eine Taste gedrückt, so bleibt diese Anzei-
ge so lange sichtbar, bis die Taste wieder 
losgelassen wird. Dies ermöglich das einfa-
che Abschreiben der Geräteseriennummer 
(z.B. ANK675A0A2).

Nach erfolgter Registrierung Ihres Mess-
gerätes können Sie den Startbildschirm 
personalisieren. Siehe hierzu Details im 
Kapitel „Personalisieren der Startanzeige“.

Menüleiste

Über die Menüleiste lassen sich die gewünschte Messfunktion und 
Zusatzeinstellungen auswählen.

Messfunktion Anzeige-
auswahl

Speichermenü & 
Batteriestatus

Eingangs-
filter

Setup-
Bereich
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Messfunktionen

•	 SPL/RTA:		 Schalldruck & RTA
•	 RT60: 		  Nachhallzeit
•	 FFT:			   Echtzeit-Zoom FFT
•	 Polarity:		  Lautsprecherpolarität 
•	 Delay:		  Laufzeit
•	 RMS/THD:	 Pegel und Verzerrung
•	 STI-PA:		  Sprachverständlichkeit
•	 Calibrate:	 Mikrofon-Kalibrierung

Anzeigeauswahl

Die Resultate der SPL/RTA, RT60 und 
STI-PA Messfunktion lassen sich auf zwei 
verschiedene Arten anzeigen.
Die Messfunktion SPL/RTA zeigt z.B. 
im Modus „123“ den numerischen 
Breitband-Schallpegelwert an, während im 
Grafik-Modus die Echtzeit-Oktavanalyse 
erscheint.

Schnellumschaltung
Drücken Sie die ESC Taste sowie die linke 
oder rechte Pfeiltaste gleichzeitig, um 
zwischen den beiden Resultatanzeigen der 
jeweiligen Messfunktion direkt hin und her 
zu wechseln.
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Eingangsfilter

Abhängig von der gewählten Messfunktion sind folgende Filtersätze 
verfügbar:

SPL/RTA Funktion:

Filter Anwendung

FLAT
Flacher Frequenzgang 
(keine Filterung)

Alle Signalkomponenten gehen ohne 
Gewichtung in das Ergebnis ein - meist 
nur für Spezialanwendungen benötigt.

A-WTD	
A-gewichtetes Filter gem. 
IEC 61672

Schallpegelmessungen mit A-Gewich-
tung, d.h. zur Annäherung an das 
menschliche Hörempfinden

C-WTD
C-gewichtetes Filter gem. 
IEC 61672

Für sehr hohe Schallpegel. Überprüfen 
Sie die Testspezifikationen zur Filterein-
stellung!

X-CRV-1 

Invertiertes X-Filter gem. 
ISO 2969

Für Kinoinstallationen. Bei eingeschalte-
tem X-CRV-1 Filter muss der Frequenz-
gang der Kinobeschallung exakt linear 
sein.

RLB (Revised Low-
frequency B-curve)
gem. AES Standard 
“Loudness Assessment of 
Music and Speech” 2004

Anwendung für Lautheitsmessungen von 
Rundfunk- und Fernsehmaterial. Das 
RLB Filter korreliert sehr gut mit dem 
Lautheitsempfinden des menschlichen 
Ohres.
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RMS/THD Funktion:

Filter Anwendung

FLAT
Flacher Frequenzgang 
(keine Filterung)

Grundeinstellung für allgemeine Mes-
sungen.

A-WTD	
A-gewichtetes Filter gem. 
IEC 6167

Messung des Hintergrundrauschens, 
z.B. im Rundfunkbereich

C-WTD
C-gewichtetes Filter gem. 
IEC 61672

Spezialanwendungen

HP400
Hochpass 400 Hz gem. 
DIN 45045, 
-120 dB/Dek.

Entfernt Netzspannungseinflüsse (50/60 
Hz) vom Testsignal.

HP19k
Hochpass 19 kHz

Messung eines 20 kHz Pilottons bei 
Warn- und Durchsagesystemen.
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Setup Bereich

Der Setup-Bereich ermöglicht dem 
Benutzer das individuelle Anpassen der 
Grundeinstellungen des AL1:
•	 Bewegen Sie den Cursor auf das 

entsprechende Feld und drücken Sie 
die Enter-Taste.

•	 Selektieren Sie den benötigten Status 
mittels der Pfeiltasten.

•	 Drücken Sie die Enter-Taste.

AUTO POWER OFF bestimmt die Verzögerungszeit, nach der sich der AL1 
nach dem letzten Tastendruck automatisch ausschaltet. Die verfügbaren 
Zeiten sind: 3, 10, 30, oder 60 Minuten sowie DISABLE (d.h. kein 
automatisches Ausschalten). Im letzteren Falle muss der Anwender das 
Gerät manuell abschalten, sonst läuft es weiter, bis die Batterien leer sind. 

	 Acoustilyzer verbunden mit MiniLINK PC Software
Solange der AL1 an einen PC mit MiniLINK Software angeschlossen ist, 
wird das Messgerät vom PC gespeist. Die Stromsparfunktionen „Auto 
Power Off“ und „Auto Light Off“ sind dabei ausgeschaltet. Sobald die 
MiniLINK Software abgeschaltet wird, bleibt die Stromversorgung vom 
PC zum Acoustilyzer aufrecht, jedoch sind die Stromsparfunktionen 
wieder eingeschaltet.

AUTO LIGHT OFF bestimmt, wie lange die Hintergrundbeleuchtung 
nach dem letzten Tastendruck eingeschaltet bleibt. Die verfügbaren 
Einstellungen sind: 3, 10, oder 60 Sekunden sowie DISABLE (d.h. 
keine automatische Abschaltung). Je länger die LCD-Hinterleuchtung 
eingeschaltet ist, desto kürzer ist die Batterielebensdauer.

LCD CONTRAST ändert den Kontrast der Anzeige. Dieselbe Einstellung 
kann mittels gleichzeitigem drücken der ESC- und ↑ / ↓-Taste erreicht 
werden.

MULTIPLE SETUP erlaubt das Speichern individueller Geräteeinstellungen. 
Im Status DISABLE merkt sich der AL1 jeweils den vor dem letzten 
Ausschalten aktiven Zustand. Bei ENABLE lassen sich hingegen vier 
verschiedene Gerätesetups speichern. Dazu erscheint beim Aufstarten 
die Meldung SELECT SETUP: 1 2 3 4 auf der Anzeige.
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Speichermenü & Batteriestatusanzeige

Die Speicherfunktion (MEM) ermöglicht 
das Abspeichern der numerischen 
Messwerte mit oder ohne Screenshots im 
internen Gerätespeicher. Alle Messungen 
werden automatisch mit einem eindeutigen 
Dateinamen versehen, der sich aus dem 
Buchstaben „A“, einer fortlaufenden 
Nummer von 001 - 999 und einem Kürzel 
für die Messfunktion zusammensetzt, z.B. 
„A001_RMS_THD“ od. „A002_RT60“ (nach 
„999“ folgt wieder „001“). 

Speichern, betrachten, löschen und laden 
Sie die Messergebnisse wie folgt:

•	 STORE+BMP
Speichert das numerische Messresultat 
zusammen mit dem aktuellen Anzeige-
inhalt im BMP (Bitmap) Format.

•	 STORE
Speichert nur das numerische Messre-
sultat und benötigt somit weniger Spei-
cherplatz.

•	 VIEW + DELETE
Die gespeicherten Messergebnisse sind 
chronologisch von oben nach unten 
geordnet. Die letzte Messung steht 
immer am Anfang der Liste.

Der freie Speicherplatz wird in der 
rechten oberen Ecke der Menüzeile als 
Prozentzahl dargestellt.
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Alle gespeicherten Messungen lassen sich 
auf dem Gerät betrachten.
•	����������������������������������� Wählen Sie den gewünschten Dateina-

men mit dem Cursor aus.
•	 Drücken Sie die Enter-Taste und halten 

diese gedrückt.
•	 Die gespeicherte Messung wird ange-

zeigt.

Zugleich füllt sich das kleine Viereck der 
zuletzt betrachteten Speicherposition. 
Dieses Viereck ist die Markierung für 
die „Schnellrückruf-Funktion”: nach dem 
Verlassen der Speicherübersicht kann 
dieser zuletzt markierte Speicherplatz 
jederzeit durch Drücken (und halten) von 
ESC + Enter-Taste angezeigt werden.
 

Einzelne Messungen löschen
Jede gespeicherte Messung lässt sich 
einzeln löschen.
•	 Wählen Sie das „DEL“ Feld neben der 

zu löschenden Messung aus.
•	 Drücken Sie die Enter-Taste.
•	 Die Messung wird aus dem Messgeräte-

Speicher gelöscht.

Gesamten Speicher löschen
Der komplette Speicher kann durch das 
Feld „DEL ALL“ gelöscht werden.
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LOAD
Der Acoustilyzer unterstützt das Laden 
vorher gespeicherter Messergebnisse. 
Damit lassen sich die Resultate einer 
früheren Messung nachträglich am 
Messgerät analysieren.

Folgende Messfunktionen unterstützen die 
LOAD Funktion:
•	 SPL/RTA
•	 RT60
•	 FFT
•	 STI-PA

Achtung:	Aktuell aktive Messungen 
laufen auch während der 
Anzeige älterer Resultate im 
Hintergrund weiter.

Anwendungsbeispiel SPL/RTA:
•	 Wählen Sie LOAD im Speichermenü 

und drücken Sie die Enter-Taste.
•	 Auf der Anzeige erscheinen die 

verfügbaren Dateien.
•	 Wählen Sie die gewünschte Datei aus 

und bestätigen Sie durch Drücken der 
Enter-Taste → das vordere Rechteck 
wird gefüllt.

•	 Drücken Sie die ESC Taste (Cursor 
springt auf OK) und bestätigen Sie mit 
Enter.
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Das vom Speicher geladene Testresultat 
wird nun angezeigt, wobei die Abkürzung 
„LOD“ im MEM Feld blinkt.

Die individuellen Einzelbandmesswerte 
können ausgelesen werden, die Y-Achse 
angepasst und die Leq oder min/max. 
Testresultate angezeigt werden. Nicht 
anwendbare Funktionalitäten sind nicht 
selektierbar.

Mittels Selektion von LIVE MODE im 
Speichermenü wird wieder die aktuelle 
Messfunktion angezeigt.

Batterieanzeige
Sobald die Batterien beinahe leer sind 
blinkt das „Batterie leer“ Symbol anstatt der 
MEM Anzeige in der Menüauswahl.
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4.	 Messfunktionen

Übersicht

Funktion Anzeigen-
auswahl Details

SPL/RTA Schallpegelmesser
Schalldruckpegel SPL, MAX/MIN SPL, LEQ, 
LcPEAK
Spektralanalyse
1/1 und 1/3 Oktavband Echtzeitspektrum 
zeigt SPL, MAX/MIN SPL und LEQ pro Band.

RT60 Nachhallzeit
in Oktavbandauflösung, basierend auf T20 
Messungen.
Nachhallzeit
detaillierte Messresultate in Sekunden inklusive 
Korrelationsfaktor 

FFT Echtzeit-Zoom FFT
POLARITY Polaritätstest

von Lautsprechern oder elektrischen Signalen
DELAY Laufzeit

Laufzeitmessung zwischen einem elektrischem 
Referenzsignal und einem akustischem Signal

RMS/THD Elektrische Messungen
Pegel RMS, THD+N, Frequenz

STI-PA Sprachverständlichkeit
von Beschallungsanlagen als STI oder CIS 
Wert (diese Funktion ist nur nach Freischaltung 
verfügbar)
Sprachverständlichkeit
LEQ und Modulationsindex Ergebnisse der 
einzelnen Test-Frequenzbänder

CALIBRTE Kalibrierungsmenü
zur Kalibrierung des Messmikrofons (per 
Default auf das MiniSPL konfiguriert)
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SPL/RTA - Schallpegelmesser

Der Acoustilyzer bietet eine umfangreiche Schallpegelmessfunktion 
mit Zeitgeber (Timer) für Einzellmessungen und sich wiederholende 
Messaufgaben. Alle Messresultate lassen sich im internen Speicher für die 
weitere Analyse ablegen.

Folgende Parameter stehen als grosse oder kleine Anzeige zur Verfügung:

•	 SPL	 Aktueller Schalldruckpegel
•	 MIN SPL	 Minimaler Schalldruckpegel
•	 MAX SPL	 Maximaler Schalldruckpegel
•	 LEQ	 äquivalenter Dauerschallpegel (Mittelungspegel)
•	 PreLEQ	 LEQ der vorangegangenen Messperiode (nur bei 		

	 Timereinstellung „REPEAT“ verfügbar)
•	 LcPEAK	 C-bewerteter höchster absoluter Momentanwert des 		

	 Schalldruckpegels

Der eingebaute Timer erlaubt:
•	 die LEQ, LcPEAK und MAX/MIN SPL Messung nach einer bestimm-

ten Zeit zu stoppen (SINGLE MODE), oder
•	 die LEQ, LcPEAK und MAX/MIN SPL Messung periodisch zurückzu-

setzen und neu zu starten (REPEATE MODE).

Messbereich Einstellung
und Indikator

Timer 
Status

Pause Aktuelle/Restliche 
Messdauer

Reset Testzyklus 
Periode

SPL Bargraph und 
Messbereichsanzeige Zeitgewichtung

Grosse 
Resultanzeige

Kleine 
Resultanzeige
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Anwendungsbeispiel: „Timer Status” Einstellung

TIMER OFF
Alle Messwerte werden kontinuierlich und 
ohne zeitliche Begrenzung gemessen. 
Die „ACT“ Anzeige gibt die verstrichene 
Messdauer wieder. 

TIMER SINGLE
Schallpegelmessung während einer ge-
wählten Dauer:
•	 Wählen Sie die gewünschte Messdauer 

und drücken Sie die Enter-Taste → die 
Messung startet.

•	 Die Uhr zählt rückwärts bis Null. Sobald 
die Messung beendet ist, blinkt die Uhr 
mit „00.00.00”. 

•	 Die Messresultate LEQ, LcPEAK und 
MAX/MIN SPL werden eingefroren.

•	 Ein Ändern der Testzykluszeit oder die 
Anwahl des „Reset“ Symbols startet die 
Messung von neuem.

TIMER REPEAT
Sich wiederholende Schallpegelmessung 
während einer gewählten Messdauer:
•	 Wählen Sie die gewünschte Messdauer 

und drücken Sie die Enter-Taste → die 
Messung startet.

•	 Die Uhr zählt rückwärts bis Null. 
Nachdem die Messung beendet ist, 
beginnt sofort die nächste Messung.

•	 Der zuletzt gemessene LEQ kann 
als PreLEQ angezeigt werden (sehr 
hilfreich z.B. bei Konzerten).

•	 Ein Ändern der Testzykluszeit oder  
Anwählen des „Reset“ Symbols startet 
die Messung von neuem.
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Pause: Die LEQ, LcPEAK und MAX/MIN SPL Messung kann unterbrochen 
werden (der aktuelle SPL Messwert wird weiter gemessen und 
angezeigt):
•	 Wählen Sie das „Pause“ Symbol und Sie drücken die Enter-Taste → 

das Pausesymbol blinkt. 
•	 Erneutes Betätigen des Pause Symbols führt die Messung fort.

Reset: Wählen Sie für einen Neustart der Messung das „Reset“ Symbol an. 
Dies setzt Messzeit und -resultate zurück.

Testzyklus-Periode: benötigt für SINGLE und REPEAT Timer.
•	 SINGLE:	 voreingestellt auf 10 Minuten
•	 REPEAT: voreingestellt auf 10 Sekunden

Aktuelle/Restlich Messzeit: in Stunden:Minuten:Sekunden

Grosse und kleine Resultatanzeige: Zwei der zuvor beschriebenen 
Messergebnisse können gleichzeitig dargestellt werden.

Zeitgewichtung: Alle SPL Messungen (SPL und MAX/MIN SPL) sind zeit-
lich gewichtete Messungen. Schnelle Wechsel des Schalldruckpegels 
werden mit wählbaren Zeitkonstanten geglättet. Mögliche Zeitkonstan-
ten nach IEC 61672 sind:

•	 SLOW (lange Anstieg- und Abfallzeit, Zeitkonstante = 1s)
•	 FAST   (kurze Anstieg- und Abfallzeit, Zeitkonstante = 125ms)

Übersteuerung

Die OVL Anzeige blinkt sobald die Ein-
gangsspannung den Maximalpegel des 
gewählten Eingangsbereiches einmal 
überschritten hat. Die LEQ und LcPEAK 
Anzeige kann in diesem Fall ungenau 
sein. Durch starten einer neuen Mes-
sung erlischt die OVL Anzeige.
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Messbereichseinstellung und -indikator:
	

	 Der AL1 verfügt über drei Messbereich. Die Bereiche sind von der 
Empfindlichkeit des verwendeten Mikrofons abhängig. Mit dem MiniSPL 
stehen folgende Messbereich zur Verfügung:

 
		  20 to 100 dB		  40 to 120 dB		  60 to 140 dB

 
Der aktuelle Messbereich wird unterhalb der Balkenanzeige dargestellt 
und kann duch Betätigen der Pfeile ausgewählt werden. Die 
Balkenanzeige zeigt den aktuellen Schalldruckpegel an.

Primärer Anzeigebereich 
	 Innerhalb des „Primären Anzeigebereiches“ wir die optimale 

Messgenauigkeit erzielt. Ein richtig gewählter Messbereich verhindert 
Übersteuerungen und minimiert den Einfluss des Eigenrauschens auf 
das Messergebnis. 

 
Die beiden Pfeile unter dem „RNGE“ Symbol helfen bei der Wahl 
des richtigen Messbereiches. Ist der ankommende Schalldruckpegel 
für den gewählten Messbereich zu klein, beginnt der Abwärtspfeil zu 
rotieren - die gemessenen Werte sind tendenziell zu hoch. Steht noch 
eine empfindlicherer Messbereich zur Verfügung kann dieser durch 
Betätigen des rotierenden Pfeils gewählt werden.

Achtung:	 Eine Änderung des Messbereiches startet die aktuell 
laufenden Messungen erneut.

Beim Überschreiten des primären 
Anzeigebereiches werden drei Pfeile 
an Stelle der grossen Resultatanzeige 
abgebildet. Um den nächst höheren 
Messbereich zu erreichen wählen Sie 
den rechten Pfeil mit dem Cursor und 
drücken Sie die Enter-Taste.
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SPL/RTA - Echtzeitspektralanalyse

Die Acoustilyzer Schallpegelmessung umfasst eine 1/3 oder 1/1 Oktavband-
Analyse mit Klasse-0 Filtern (RTA). Der SPL, MAX/MIN SPL und LEQ 
Messwert werden dabei für jedes einzelne Band angezeigt.

Gespeicherte Messresultate können auf dem Messgerät arithmetisch 
gemittelt werden. Die MAX-MIN Anzeige ist hilfreich für eine detaillierte 
Raumanalyse.

Audio-
spektrum

SET 
Menü

Pause Reset Messwert an 
Pfeilposition

X-Achse mit manueller 
Bereichseinstellung

Y-Achse

Das Spektrum wird fortlaufend gemessen und angezeigt, ein Wechsel der 
Anzeige von  zu  beeinflusst die Messungen in keiner Weise.

Messfilter 
Die Filter für die Breitbandanzeige ( ) und die RTA ( ) können 
weitgehend unabhängig voneinander gewählt werden. So ist z.B. 
eine ungefilterte RTA Anzeige in Kombination mit einer A-Gewichteten 
Breitbandmessung realisierbar. 

Achtung:	Beim Wechsel der Filtereinstellung wird die Messung neu 
gestartet.
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SET Menü
Das SET Menü ermöglicht die Einstellung 
der folgenden Messungen und 
Anzeigeoptionen:

RES - Auflösung
Wählen Sie zwischen 1/3 Oktavband oder 
1/1 Oktavband-Auflösung mittels der Enter-
Taste.

SHOW - Testresultat
Wählen Sie für die Anzeige eine der 
folgenden Messungen aus:
•	 aktueller SPL,
•	 min & max SPL oder
•	 LEQ pro Band.

Der aktuelle SPL wird mit vollen Säulen 
angezeigt. 

Der gemittelte Leq-Wert wird mit leeren 
Säulen angezeigt.

Der min & max SPL wird mit vollen Säulen 
angezeigt, wobei für jedes Band der 
maximale & minimale Schalldruck sowie 
die Differenz zwischen beiden Werten 
individuell ausgelesen werden kann. 

Bewegen Sie den Cursor auf das Feld für 
den Messwert der Pfeil-Position und wählen 
Sie mit der oberen & unteren Pfeiltaste das 
max., min. bzw. Differenz-Resultat aus. 

	 - max. SPL
	 - min. SPL
	 - max-min. SPL
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TWTD - Zeitgewichtung
Zeitgewichtung nach IEC 61672 für den 
aktuellen Schalldruck:
•	 SLOW (lange Anstieg- und Abfallzeit)
•	 FAST (kurze Anstieg- und Abfallzeit)
Die Zeitgewichtung für die Breitbandanzeige 
( ) und die RTA ( ) sind immer 
identisch.

HOLD - Cursor
Der Pfeil der Resultat-Anzeige springt je-
weils automatisch auf den höchsten aktu-
ellen Schallpegelwert im Spektrum. Dabei 
lässt sich die Verweildauer einstellen, d.h. 
der Pfeil bleibt für 1 - 9 Sekunden beim 
Frequenzband mit dem zuletzt höchsten 
Schalldruckpegel. Diese Funktion ist z.B. 
zur Auffindung von Rückkopplungsfrequen-
zen im Livebereich hilfreich.

Pause: erlaubt die Unterbrechung einer Messung:
•	 Wählen Sie das Pause-Symbol an und drücken die Enter-Taste →

das Pausesymbol blinkt. 
•	 Drücken Sie erneut die Enter-Taste um mit der Messung fortzufah-

ren; dies wird ersichtlich aus der nun weiter laufenden Messuhr. 

Messwert an Pfeilposition: dieses Feld zeigt den aktuellen Messwert 
des Frequenzbandes unter dem Pfeil. Der Pfeil folgt automatisch dem 
höchsten Pegelwert oder kann manuell kontrolliert werden:
•	 Wählen Sie das Messwertfeld und drücken Sie die Enter-Taste → ein 

schwarzer Rahmen blinkt um die Anzeige.
•	 Bewegen Sie den Pfeil mit den Pfeil-Tasten über das gewünschte 

Band, dessen Messwerte Sie auslesen wollen.

Reset: Wählen Sie das Reset-Symbol an und drücken die Enter-Taste, um 
die Schallpegelmessung neu zu starten und die Messzeit bzw. Messre-
sultate auf Null zurückzusetzen.
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X-Achse: 20 Hz - 20kHz in logarithmischer Skalierung. 

Y-Achse: Die Skalierung der Y-Achse (Sensitivität) lässt sich manuell 
einstellen.
•	 Selektieren Sie den angezeigten oberen Y-Achsenwert und drücken 

Sie die Enter-Taste.
•	 Verwenden Sie die ↑ / ↓Pfeiltasten zur Verschiebung der Y-Achse, 

bzw. die ← / → Pfeiltasten zum Zoom In/Out.
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SPL/RTA - Speicherfunktion

Die SPL/RTA Messung unterstützt folgende, spezielle Speicherfunktionen:

Schallpegelmessung

•	 LOGGING: Die Messwerte werden nach Ablauf eines wählbaren 
Aufzeichnungsintervalls ∆t zyklisch im internen Messgerätespeicher 
als Tabelle abgelegt.

Echtzeit-Spektralanalyse (RTA)

•	 LOAD: Messwerte können zur detaillierten Auswertung vom internen 
Speicher in die AL1 Anzeige zurück geladen werden.

•	 MATH: Berechnung des Durchschnitts gespeicherter Messresultate.

Logging
Um eine längere Schallpegelmessung zu dokumentieren (z.B. während 
einer Veranstaltung) kann der AL1 den Pegelverlauf über mehrere 
Stunden abspeichern. Dabei legt das Gerät nach jedem Ablauf eines 
Aufzeichnungsintervalls ∆t die Messwerte im internen Speicher ab. 
Diese Werte können später mit Hilfe der MiniLINK PC Software aus dem 
Messgerät ausgelesen und z.B. über Microsoft Excel in ein aussagekräftiges 
Pegeldiagramm umgewandelt werden.

Hinweis:		 Die gespeicherten Messwerte bleiben auch dann im AL1 
erhalten, wenn sich während der Messung die Batterien 
entleeren.

Folgende Parameter werden beim Loggen aufgezeichnet:

LEQ	 LEQ über die gesamte Messperiode. Die Messperiode wird 
durch den Timer vorgegeben und angezeigt.

PreLEQ	 LEQ der vorangegangenen Messperiode (nur bei Timerein-
stellung „REPEAT“ verfügbar).
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LEQ_dt	 Kurzzeit LEQ über ein Aufzeichnungsintervall ∆t. Um den 
LEQ eines beliebigen Zeitabschnitts zu erhalten können 
LEQ_dt Werte kombiniert werden:

	

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
⋅⋅= ∑

=

N

n

dtLEQ n

N
LEQ

1

10
_

101log10

MIN_dt	 Minimaler SPL Wert des aktuellen Aufzeichnungsintervalls ∆t; 
Zeitgewichteter Messwert (SLOW/FAST).

MAX_dt	 Maximaler SPL Wert des aktuellen Aufzeichnungsintervalls ∆t; 
Zeitgewichteter Messwert (SLOW/FAST).

Beispiel einer SPL/LEQ Log Visualisierung mit Microsoft Excel
(ohne LcPEAK)

LcPeak	�������������������������������������������������������� C-bewerteter höchster absoluter Momentanwert des Schall-
druckpegels über die gesamte Messperiode. Die Messperio-
de wird durch den Timer vorgegeben und angezeigt.

LcPeak_dt	 LcPEAK des aktuellen Aufzeichnungsintervalls ∆t.

SPL_Act	���������������������������������������������������������� Aktueller Schalldruckpegel am Ende des Aufzeichnungsinter-
valls ∆t. Die Messwerte LEQ_dt, MIN_dt und MAX_dt sind 
für ein Aufzeichnungsintervall deutlich aussagekräftiger als 
dieser Einzellwert.
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Beispiel einer SPL/LEQ Log Visualisierung mit Microsoft Excel
(nur LcPEAK)

OVER_dt	 Eine “1” signalisiert eine Übersteuerung während des 
Aufzeichnungsintervalls ∆t (alle Messwerte sind tendenziell 
zu niedrig).

OVER_Hold	 Eine “1” signalisiert eine Übersteuerung währende der ge-
samten Messperiode. 

UNDER_dt	 Eine “1” signalisiert, dass der Eingangspegel den primären 
Anzeigebereich während des Aufzeichnungsintervalls ∆t 
unterschritten hat (alle Messwerte sind tendenziell zu hoch).

 

Starten der SPL/RTA Aufzeichnung
Die Auswahl von LOGGING im MEM Menü 
führt zum Messzeit - Einstellfenster. 

Einstellung der Messzeit
Die maximal verfügbare Messzeit (END) 
hängt vom freien Messgerätespeicher 
und vom gewählten Aufzeichnungs-
intervall Δt ab. Der Logger kann bis 
zu 580 Messpunkte aufnehmen. Die 
Intervalldauer Δt für die Speicherung 
der Messwerte ist frei wählbar (Format  
hh:mm:ss).
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Achtung:	 Auch wenn der Logger aktiv 
ist kann ohne Beeinflus-
sung der Messung zwischen 
Breitbandanzeige und RTA 
gewechselt werden

Speicheransicht der Pegelmessung
Die SPL und LEQ Messung wird unter dem 
Filenamen „Axxx_LOGSPL” abgespeichert, 
wobei xxx eine fortlaufende Nummer von 
001 - 999 ist. Die einzelnen Messdaten sind 
unter diesem Speicherplatz hinterlegt und 
können am PC ausgelesen werden.

LOAD - Laden von Testergebnissen

Für detaillierte Informationen siehe das 
Kapitel „Speichermenü“.
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MATH - Mathematische Mittelung von Messdaten

Die MATH Funktion berechnet den Durch-
schnitt gespeicherter Spektralmessungen.

Anwendungsbeispiel:
•	 Wählen Sie den Eintrag „MATH“ → 

Anzeige der wählbaren Messdateien.
•	 Selektieren Sie die für die Mittelung 

vorgesehenen Dateien und Drücken der 
Enter-Taste → das vordere Viereck wird 
bei jeder gewählten Datei ausgefüllt.

•	 Drücken Sie die ESC Taste (der Cursor 
springt auf OK) und bestätigen Sie mit 
Enter.

Als Ergebnis wird das gemittelte Spektrum 
angezeigt und die Abkürzung MAT blinkt im 
MEM Feld.

Die gemittelten Band-Pegelwerte können 
nun ausgelesen, die Y-Achse individuell 
skaliert und die einzelnen LEQ bzw. min./
max. Messresultate angezeigt werden.
•	 Kehren Sie in die aktive Messwertanzeige 

durch Auswahl des Eintrags LIVE MODE 
im Speichermenü MEM zurück.
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Nachhallzeit RT60

Der Acoustilyzer unterstützt die Nachhallzeitmessung in Oktavbändern 
gem. der Norm ISO3382 mit Auto-Trigger, Auto-Bereichseinstellung und 
Mittelungsfunktion.

Was ist Nachhallzeit RT60?
Die Nachhallzeit RT60 ist diejenige Zeit, während der ein Schallpegel 
in einem Raum um -60 dB abfällt, nachdem das akustische Testsignal 
gestoppt wird. Zur einfachen praktischen Ausführung dieser Messung wird 
in der Praxis die T20, d.h. die Dauer für einen Abfall um -20 dB gemessen, 
da hierfür bereits ein geringerer dynamischer Messbereich von ~35 dB 
genügt. Das RT60 Testresultat lässt sich aus der gemessenen 20 dB 
Abfallzeit berechnen.

Test Signal
NTi Audio empfiehlt rosa Rauschen als Testsignal zu verwenden. 
Verschiedene entsprechende Testsignale mit unterschiedlichen Ein/Aus 
Intervallzeiten finden sich auf der beigelegten Acoustilyzer Audio CD. 
Alternativ generiert der NTi Audio Minirator das benötigte rosa Rauschen.

a. Bargraphanzeige

Oktavband 
scroll  
63Hz - 8kHz

Oktavbänder

Start Pause Status der 
Messung

Individuells Oktav- 
bandspektrum

RT60 obere 
Messmarkierung

RT60 untere 
Messmarkierung

X-Achse,
Pegel mit 
10 dBSPL  
Skala

Anzahl 
der Test-
resultate 
für die 
automat. 
MittelungBerichs-

einstellung, 
zur initialen 
Geräusch-
messung
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b. Wie messe ich RT60?

Der Testraum wird über Lautsprecher mit rosa Rauschen beschallt. Nachdem 
der Raum mit Schallenergie „gefüllt“ ist, wird das Testsignal abgeschaltet. 
Der AL1 erkennt diese Abschaltung und misst die Nachhallzeit. 

Für eine konkrete Messung folgen Sie bitte den Instruktionen:

Ranging 
•	 Schalten Sie die Rauschquelle ab.
•	 Wählen Sie RANGE und drücken Sie 

die Enter-Taste, damit das Gerät den 
Umgebungs-Lärmpegel ohne Testsignal 
aufnehmen kann.

•	 Das SET RANGE Anzeigefeld erscheint 
→ bestätigen Sie die automatische 
Bereichseinstellung mit OK.

Nun sind die unteren und oberen 
Messmarkierungen gesetzt. Diese zeigen 
den maximal zulässigen Umgebungslärm 
(untere Markierung) sowie den minimal 
notwendigen Pegel des rosa Rauschens 
(obere Markierung) an.

•	 Schalten Sie dasjenige rosa 
Rauschsignal an, dessen Ein/Aus 
Intervallzeit auf den Raum angepasst ist 
(grosse Räume → längere Intervallzeit).

Achtung:	 Starten Sie mit einem niedrigen 
Schallpegel, um Gehörschäden 
zu vermeiden.
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•	 Erhöhen Sie nun den Testpegel so 
lange, bis er in allen Oktavbändern 
über der oberen Testmarke liegt. Dabei 
kann ein Equalizer zur Hilfe genommen 
werden, um einzelne Bänder zusätzlich 
zu verstärken.

Start der RT60 Messung
•	 Selektieren Sie das START Symbol und 

drücken Sie die Enter-Taste, um die 
RT60 Messung zu beginnen.

•	 Die Statusanzeige schaltet um auf 
ARMED.

•	 Schalten Sie die Wiedergabe des 
Testsignal ein → die Oktavbandpegel 
müssen die obere Testmarkierung 
während des rosa Rauschens 
überschreiten, und in den Pausen unter 
die untere Testmarkierung absinken.

•	 Führen Sie immer mehrere Messzyklen 
durch, um eine arithmetische Mittelung 
der Messergebnisse zu ermöglichen.

•	 Schalte das Testsignal aus, sobald 
sie genügend Messzyklen ausgeführt 
haben.

Die Bestätigungszeichen geben an, ob beim 
entsprechenden Testzyklus die jeweiligen 
Oktavbänder erfolgreich gemessen werden 
konnten.
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RT60 Testresultat auslesen
Die detaillierten RT60 Messresultate (x.xx 
Sekunden pro Oktavband) erscheinen auf 
der RT60 Detailanzeige.
 
Wählen Sie die RT60 Detailanzeige:
•	 über das Anzeigemenü, oder
•	 mittels gleichzeitigen Drückens der 

ESC- und linker/rechter Pfeiltaste.

Achtung:	 Während einer laufenden RT60 
Messung ist das Speichermenü 
nicht verfügbar.

c. RT60 Testresultat auslesen

Anzahl 
der Test-
resultate 
für die 
automat. 
Mittelung

Oktavband 
scroll  
63Hz - 8kHz

Testresultat 
in Sekunden

Korrelationsfaktor in %
oder Messungenauigkeit

Relatives 
Testresultat als 
Bargraph

Testresultat 
Auswahl

Testresultat 
löschen

Start Pause

Testresultat Auswahl: die RT60 Messfunktion unterstützt die sequentielle 
Messung & Speicherung der Nachhallzeit innerhalb einer Testsequenz. 
Somit lässt sich eine automatische Mittelung der Messergebnisse am 
Messgerät durchführen.
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Prüfen Sie mittels der Pfeiltasten die individuellen Messergebnisse. 
Dabei wird folgendes angezeigt:

LAST - letztes Messergebnis
Anzeige des Messergebnisses des 
letzten Testzyklus.

Einzel-Testzyklusresultat
Das individuelle einzelne Testresultat 
ist markiert mit CYC xx, wobei xx eine 
fortlaufende Nummer ist.

Gemitteltes Testresultat
In der AVRG Anzeige wird das 
gemittelte Messresultat aller 
fehlerfreien Messungen angezeigt. 
Der Korrelationsfaktor in Prozent wird 
durch den Messgenauigkeitsfaktor in % 
ersetzt.

Relatives Messergebnis als Bargraph: Zum vereinfachten Vergleich der 
Messdatenauswertung werden die Nachhallzeiten für jedes Oktavband 
auch als Bargraph angezeigt, wobei dasjenige Band mit der längsten 
Nachhallzeit mit 100% Länge dargestellt wird.

Korrelations- 
Faktor in %

Korrelationsfaktor in %
(wird bei den einzelnen CYCxx Messwerten 
angezeigt)
Der Korrelationsfaktor bemisst die Linearität 
des akustischen Abfalls. Ein idealer, d.h. 
perfekt linearer Abfall entspricht 100%, 
während in der Praxis typische Werte von 
80 - 100% auftreten.
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Ungenauigkeits- 
Faktor in %

Messgenauigkeitsfaktor in %
(wird nur beim gemittelten Wert, d.h. im 
AVRG Modus angezeigt)
Der bemisst die statistische Verteilung 
der einzelnen Messresultate aller 
gemessenen Testzyklen. Ursachen 
für Resultatschwankungen sind z.B. 
Änderungen im rosa Rauschen oder zu 
kurze Ein/Aus Intervallzeiten.
Typische Messgenauigkeitsfaktoren liegen 
zwischen 0 - 15% (vgl. Details im Standard 
ISO 3382).

Lösche dieses 
Messergebnis

Fehleranzeigen
Sollten während einer Nachhallzeit-Messung 
Probleme auftauchen, die eine erfolgreiche 
Durchführung verunmöglichen, dann 
informiert der AL1 den Benutzer darüber 
mittels verschiedener Fehleranzeigen. 
Solche ungültige Messungen werden 
zudem bei der Mittelungsberechnung nicht 
berücksichtigt.
•	 LOW LEVL

D.h. „zu niedriger Testsignal-Pegel“  
→ erhöhen Sie den Pegel des rosa 
Rauschens um sicherzustellen, dass er 
die obere Testmarkierung übertrifft.

→ wählen Sie ein RT60 Testsignal mit 
längerer Ein/Aus Intervallzeit.

•	 CORR<70%
Unzuverlässige Messung, Korrelations-
faktor ist kleiner als 70%.

•	 T>18S
Die gemessene Nachhallzeit RT60 
übersteigt die maximale Zeitlimit.

→ Wiederholen Sie das Ranging und 
starten Sie nochmals die Messung.
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FFT Analyse

Der Acoustilyzer beinhaltet eine sehr schnelle Echtzeit Zoom FFT-
Analyse mit einer maximalen Auflösung von 0.7 Hz über den gesamten 
Frequenzbereich. Auf dem LCD werden 93 Frequenzbins gleichzeitig 
angezeigt.

Die FFT Spektrums-Messung ist das ideale Werkzeug zur Erkennung von 
Kammfilter- und schmalbandigen Effekten. Sie ermöglicht eine detaillierte 
Messung des Frequenzganges eines Audiosystems.

FFT Audio 
Spektrum

SET 
Menü

Pause Messdaten-
feld

Startfrequenz 
auf der Anzeige

Y-AchseEndfrequenz 
auf der Anzeige

Grösse des 
angezeigten 
Frequnzbereichs

SET Menü
Im SET Menü lassen sich die folgenden 
Messoptionen einstellen.
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RNGE - AL1 Eingangsbereich
Der AL1 passt die Eingangsempfindlichkeit 
automatisch auf den aktuellen Umgebungs-
Geräuschpegel an, sobald Sie die Enter-
Taste drücken. Diese Abstimmung sollte 
vor jeder Messung ausgeführt werden, 
sowie bei Auftreten von Übersteuern.

SHOW - Messresultat-Anzeige
Auswahl des aktuellen (SPL) oder des 
gemittelten Schallpegels (LEQ). Letzterer 
wird bei erneuter Range-Einstellung oder 
SHOW: LEQ Selektion neu gestartet.

HOLD - Cursor
Der Pfeil der Resultat-Anzeige springt 
jeweils automatisch auf den höchsten 
Wert im Spektrum. Dabei lässt sich die 
Verweildauer einstellen, d.h. der Pfeil bleibt 
für 1 - 9 Sekunden bei der Frequenz mit 
dem zuletzt höchsten Schalldruckpegel. 

Pause: erlaubt die temporäre Unterbrechung der laufenden FFT Analyse:
•	 Wählen Sie das Pause-Symbol an und drücken die Enter-Taste 

→ das Pausesymbol blinkt. Im Hintergrund wird das FFT-Spektrum 
sowie der aktuelle SPL Messwert weiter gemessen und angezeigt, 
aber nicht gespeichert.

•	 Drücken Sie erneut die Enter-Taste, um die Messung fortzusetzen.

Messdatenfeld: zeigt den aktuellen Messwert der Frequenz unter dem 
Pfeil an. Der Pfeil folgt automatisch dem höchsten Pegelwert oder kann 
manuell kontrolliert werden:
•	 Wählen Sie das Messwertfeld und drücken Sie die Enter-Taste → ein 

schwarzer Rahmen blinkt um die Anzeige.
•	 Bewegen Sie den Pfeil mit den Pfeil-Tasten zu der gewünschten 

Frequenz, deren Pegel Sie auslesen wollen.

X-Achse: zeigt 93 Bins in linearer Skalierung inklusive Zoomfunktionalität.
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Y-Achse: Die Skalierung der Y-Achse kann manuell eingestellt werden.
•	 Selektieren Sie den angezeigten oberen Y-Achsenwert und drücken 

Sie die Enter-Taste.
•	 Verwenden Sie die ↑ / ↓Pfeiltasten zur Verschiebung der Y-Achse, 

bzw. die ← / → Pfeiltasten zum Zoom-In/Out.

Anleitung zur FFT Analyse:

•	 Selektieren Sie die FFT Messfunktion. 
Der Pfeil zeigt automatisch auf den 
Frequenzbin mit dem höchstem Pegel. 

•	 Wählen Sie das Messdatenfeld an 
und betätigen die Enter-Taste → ein 
Rahmen blinkt um das Feld.

•	 Mit der ← / → Pfeiltaste können die 
einzelnen Messwerte nun abgelesen 
werden.

Zoomen bezüglich Cursorposition
•	 Selektieren Sie das Messdatenfeld.
•	 Zoomen Sie den Frequenzbereich mit 

den ↑ / ↓ Pfeiltasten.
•	 Verschieben Sie den X-Achsenbereich 

mit der ← / → Pfeiltaste.

Zoomen mit schneller Bereichswahl der 
X-Achse
•	 Wählen Sie das „Bandbreite“ Feld in der 

Mitte unter der X-Achse aus.
•	 Die Zoom-Funktion bezieht sich auf 

die mittlere Frequenz des aktuellen 
Bereichs.

•	 Mit der ← / → Pfeiltaste kann der 
gewünschte X-Achsenbereich schnell 
gewählt werden.
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Anwendung: FFT und weisses Rauschen

Beim ausmessen akustischer Systeme spielt weisses Rauschen eine große 
Bedeutung. Die FFT von weissem Rauschen ergibt eine horizontale Linie. 
Wird weisses Rauschen in ein elektroakustisches System eingespeist 
und mittels Messmikrofon und FFT ausgewertet, so erhält man den 
Frequenzgang des Systems mit sehr hoher Auflösung.

Ein akustisch gemessener Frequenzgang ist oft eine Kombination zweier 
Effekt:

a)	 „Echter“ Frequenzgang von Verstärker und Lautsprecher
b) Interferenzerscheinungen (→ Kammfiltereffekte)

Mit der hohen spektralen Auflösung einer FFT sind Interferenzen problemlos 
sichtbar, während diese Effekte bei der 1/3 Oktave Auflösung einer RTA 
kaum erkennbar sind. Die Zoom Funktionalität der AL1 FFT erlaubt eine 
Auflösung von bis zu 0.73Hz in jedem beliebigen Frequenzausschnitt. 

4x zoom →
Pegel um 
6 dB geringer

Weisses Rauschen & Zoomen
Die Energie von weissem Rauschen ist 
über die lineare Frequenzachse gleich 
verteilt. 

Beispiel: Weisses Rauschen mit einem 
Pegel von 0 dBu bei einer Messbandbreite 
von 20 kHz:

Wie hoch ist der Pegel bei einer 
Messbandbreite von 10 kHz?

→ 10 kHz Bandbreite enthält nur die 
halbe Energie, der Pegel ist 3dB geringer 
(10*log10(0.5)).
Exakt diese spielt sich beim „Zoom In“ der 
FFT ab: Bei jedem „Zoom In“ Schritt wird die 
Messbandbreite halbiert und der gemessen 
Pegel verringert sich um 3dB. 
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Polaritätsmessfunktion

Mit der Messfunktion „Polarity“ kann in Kombination mit dem Minirator MR1 
die korrekte Beschaltung von Kabeln und Lautsprechersystemen getestet 
werden. Der AL1 bietet dazu verschiedene Möglichkeiten.

a. Polaritätsmessung an Lautsprechern
Speisen Sie das MR1 Polaritäts-Testsignal 
in das Lautsprechersystem ein, so dass es 
akustisch gut hörbar ist.

Einstellungen am Acoustilyzer:
•	 IN:MIC (INT), bei Verwendung des 

internen Mikrofons.
•	 IN:XLR/RCA, bei Verwendung eines 

externen Mikrofons, z.B. MiniSPL.

Wählen Sie nun den Frequenzbereich für 
den Polaritätstest:
•	 FULL/MID, für Breitbandlautsprecher.
•	 WOOFER, für Basslautsprecher.

Achtung: 
•	 Bitte beachten Sie, dass die Polarität eine starke Vereinfachung 

eines recht komplexen Phasenzusammenhanges ist. Sowohl 
Lautsprecher als auch Frequenzweichen fügen einem Signal 
z.T. sehr starke Phasenverzerrungen zu.

•	 Die Polarität der einzelnen Lautsprecher in Boxensystemen kann 
durchaus unterschiedlich sein. Dies ist weder ein Fehler noch 
ein Zeichen für ein schlechtes Boxendesign.

•	 Polaritätsmessungen machen dann Sinn, wenn die korrekte 
Verkabelung gleichartiger Lautsprechersysteme verglichen 
werden soll.
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b. Polaritätsmessung von Kabeln
Das Minirator Polaritäts-Testsignal wird in 
das zu testende Kabel eingespeist. Der 
AL1 analysiert die Polarität am anderen 
Kabelende.

Einstellung am Acoustilyzer:
•	 IN: XLR/RCA, 
•	 Mode: Cable

Folgende Fehlerquellen lassen sich lokalisieren:

•	 Falsche Polarität infolge fehlerhafter Verbindungen im Kabelinnern.

•	 Kabelprobleme: Die Signalsymmetrie (Balance) kann auf verschiedene 
Kabelprobleme hinweisen, wie z.B.:

2UBAL-: der AL1 erkennt nur ein Eingangssignal auf Pin 2, d.h. es liegt 
kein Signal an Pin 3.

-UBAL3: der AL1 erkennt nur ein Eingangssignal auf Pin 3, d.h. es liegt 
kein Signal an Pin 2.

Anzeigepfeil nicht mittig deutet auf sonstige Kabelprobleme hin: siehe 
hierzu das NTi Audio Dokument „Balance application note“ (verfügbar als 
Download auf der NTi Audio Webseite).

 
Die Pegelanzeige ist für komplexere Anwendungen wie z.B. das Testen 
von Multicorekabel hilfreich (weitere Informationen finden Sie auf der NTi 
Audio Webseite).
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Laufzeitmessung
Die optimale Einstellung der akustischen Verzögerungszeit zwischen 
verschiedenen Lautsprechern - z.B. in Kirchen oder Vortragssälen - ist 
notwendig, damit die Zuhörerschaft den Eindruck behält, der Ton komme 
vom Sprecher und nicht etwa von den seitlichen Wandlautsprechern.

Der Acoustilyzer misst die Laufzeit des akustischen Lautsprechersignals 
(mit dem eingebauten Mikrofon) im Vergleich zu einem elektrischen 
Referenzsignal, das vorab am RCA- oder XLR-Eingang angeschlossen 
wird. Als Testsignal dient ein schneller Sweep, der von der AL1 Test CD 
abgespielt wird.

Berechneter 
Abstand in 
Metern/Fuss

Gespeicherte 
Referenzlaufzeit

Differenz zwischen aktueller Laufzeit 
und gespeicherter Referenz.

Start Synchronisation Synchronisations-Bargraph
100% = 100 Sekunden

Aktuelle 
Laufzeit im 
Vergleich zurm 
elektrischen 
Referenz-
signal

Statusanzeige

Anleitung zur Laufzeitmessung

Achtung:	Verwenden Sie nur CD Player ohne „Shock Protection“ 
oder solche, bei denen sie abgeschaltet werden kann. CD 
Player mit aktiver „Shock Protection“ verunmöglichen unter 
Umständen die Laufzeitmessung mit dem AL1.
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Synchronisierung des AL1 und Messung der Laufzeit von einem 
Lautsprecher zum AL1

Umschaltung 
[m][°C] ↔ [feet][°F]

•	 Spielen Sie das Testsignal für die 
Laufzeitmessung von der AL1 Test-CD 
über einen CD-Player ab.

•	 Verbinden Sie den Ausgang des CD-
Players über ein Kabel mit dem RCA- 
oder XLR-Eingang des AL1.

•	 Warten Sie, bis sich die Balkenanzeige 
auf dem AL1 vollständig gefüllt hat (d.h. 
bis sich das Gerät auf das elektrische 
Referenzsignal synchronisiert hat).

•	 Entfernen Sie das Kabel vom AL1 und 
führen das Testsignal vom CD-Player 
zu demjenigen Lautsprecher, den Sie 
überprüfen wollen.

•	 Stellen Sie sich mit dem AL1 an die 
gewünschte Position → der AL1 zeigt 
die Laufzeit in [ms] und (zur Überprüfung 
der Plausibilität) darunter die Entfernung 
zum aktiven Lautsprecher in Meter [m] 
oder Feet [f] an.

•	 Die Berechnung der Entfernung basiert 
auf 330 m/s Schallgeschwindigkeit und 
einer Temperatur von 0°C / 32°F. Geben 
Sie falls notwendig den aktuellen Wert 
der Umgebungstemperatur ein, damit 
die Entfernungsangabe exakt stimmt.

•	 Wiederholen Sie die Messung falls nötig 
an verschiedenen Positionen.

•	 Sobald sich die Balkenanzeige „geleert“ 
hat (nach ca. 100 Sekunden), erscheint 
die blinkende Meldung „SYNC TO 
CABLE“. Die bedeutet, dass der AL1 
wieder elektrisch mit dem Ausgang 
des CD-Players verbunden werden 
muss, um eine neue Synchronisation 
durchzuführen.
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Achtung:	Sie können die Synchronisation vom AL1 zum CD-Player 
auch manuell starten. Bewegen Sie dazu den Cursor auf 
das „Reset“ Symbol und drücken die Enter-Taste.

	 Halten Sie den AL1 nicht zu nahe an schallharte Flächen wie 
z.B. eine Wand oder den Boden, da dadurch Reflektionen 
auftreten, welche die Messgenauigkeit beieinträchtigen 
können.

Messung der Laufzeit-Differenz zwischen Lautsprechern
Um die Laufzeiten mehrerer, kaskadierter Lautsprechern zu optimieren, 
müssen deren Laufzeit-Differenzen zum AL1 gemessen werden.

Der AL1 vereinfacht diese Prozedur erheblich, indem er die vergleichende 
Messung zu einem Referenz-Lautsprecher unterstützt.

•	 Schalten Sie nur den Lautsprecher „A“ 
ein, der als Referenz dienen soll (z.B. in 
einer Verzögerungskette der der Bühne 
am nächsten stehende).

•	 Stellen Sie sich an die gewünschte 
Position und messen Sie die Laufzeit 
vom Lautsprecher A.

•	 Bewegen Sie den Cursor auf den 
Eintrag „STORE“ und drücken Sie die 
Enter-Taste → die aktuelle Laufzeit von 
Lautsprecher A - welche als Referenz 
dient - wird links oben angezeigt.

•	 Schalten Sie nun Lautsprecher A ab 
und verbinden dafür den CD-Player mit 
dem nächsten Lautsprecher „B“ → der 
AL1 zeigt Ihnen in der Mitte des Display 
die absolute Laufzeit zum Lautsprecher 
B an, und rechts oben - unterhalb des 
Eintrages „STO-ACT“ - die Differenz der 
beiden Laufzeiten A-B.
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Elektrische Messungen - RMS/THD

Der Acoustilyzer unterstützt einfache elektrische Messfunktionen wie
•	 Level RMS, d.h. absoluter Pegel des Eingangssignals.
•	 THD+N, d.h. Summe der harmonischen Verzerrungen plus sonstige 

Störungen. Diese Messung eignet sich insbesondere für die Erkennung 
unerwünschter Störsignale (z.B. 50 Hz Brummen).

Verzerrungen 
THD+N

Signal 
Frequenz

Signalsymmetrie-
anzeige

Pegel RMS  
Mssergebnis

 

Pegel RMS: Der Signalpegel lässt sich in dBu, dBV, dBSPL oder V 
anzeigen.

Verzerrungen THD+N: Das Resultat der Verzerrungsmessung wird in dB 
oder % angezeigt (Mess-Bandbreite 10 Hz - 20 kHz).
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Signalsymmetrie zeigt den Pegelunterschied zwischen Pin 2 und Pin 3 in 
Prozent (%) an. Die Pfeilposition lässt sich wie folgt interpretieren:

•	 Pfeil in der Mitte: das Eingangssignal ist symmetrisch (anders 
ausgedrückt: der Signal-Symmetriefehler = 0%).

•	 Pfeil nicht in der Mitte: unsymmetrisches Eingangssignal, wobei der 
Pfeil proportional zum Symmetrieproblem positioniert wird.

•	 Pfeil am linken oder rechten Ende: der Signal-Symmetriefehler 
beträgt 33% (= 6 dB) oder höher.

•	 2UBAL-: der AL1 erkennt nur ein Eingangssignal auf Pin 2, d.h. es 
liegt kein Signal an Pin 3.

•	 -UBAL3: der AL1 erkennt nur ein Eingangssignal auf Pin 3, d.h. es 
liegt kein Signal an Pin 2.

Achtung:
•	 Sobald der Signalpegel über +20 dBu liegt, muss ein -20 dB Ad-

apter (NTi Audio Zubehör) vorgeschaltet werden.
•	 Die THD+N Messung hat eine Bandbreite von 10 Hz - 20 kHz.
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Sprachverständlichkeit STI-PA (Option)

Die Messung der Sprachverständlichkeit „STI-PA“ ist eine Option zum 
Acoustilyzer AL1. Für genaue Spezifikationen kontaktieren Sie bitte Ihre 
lokale NTi Audio Vertretung.

Die STI-PA Option misst den Sprachverständlichkeitsindex „STI“ während 
einer Dauer von 15 Sekunden. Neben dem Einzelmessresultat STI (oder 
CIS) zeigt ein zweiter Schirm die individuellen Modulationsindizes und 
Bandpegel an.

Der AL1 führt die STI-PA Messung entsprechend dem aktuellen 2003 IEC 
60268-16 Standard aus und wurde von TNO (d.h. dem niederländischen 
Entwicklungsinstitut der STI-PA Norm) offiziell verifiziert.

Mehr Informationen zur Sprachverständlichkeit sowie deren Hintergründen 
sind im Anhang dieses Handbuchs zu finden.

a. STI-PA Messung

Aktueller 
Schall-
druckpegel

Messzeitfenster 
(0..15 Sekunden)

STI-PA Balkenanzeige

STI-PA 
Testresult

Startet die 
Messung

Messstatus-
anzeige

STI-PA Testresultat: Sprachverständlichkeitsindex, ausgedrückt in STI 
(Speech Transmission Index) oder CIS (Common Intelligibility Scale), 
wobei CIS wie folgt berechnet wird: CIS = 1 + log

10
(STI)

Schalldruckpegel: Aktueller SPL Wert in dBAS, d.h. mit A-Gewichtung 
und Slow (Langsamer) Zeitgewichtung.
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b. Anleitung zur STI-PA Messung

•	 Wählen Sie die STI-PA Funktion.
•	 Stellen Sie die Beschallungsanlage auf 

Notfallbedingungen ein, d.h. aktivieren 
Sie alle vorgesehenen Komponenten & 
wählen den vorgeschriebenen Pegel.

•	 Stellen Sie sicher, dass während der 15 
Sekunden Messzeit keine impulshaltigen 
Störgeräusche auftreten, da diese die 
Messgenauigkeit beeinträchtigen.

•	 Um Messfehler zu vermeiden sollte der 
gemessen Schalldruckpegel des STI-PA 
Signals mindestens 60 dBAS beträgt.

Achtung:	 Auch kürzeste Störgeräusche 
können das STI-PA Testresultat 
beeinflussen.

Signalquelle:
Die NTi Audio TalkBox simuliert einen 
menschlichen Sprecher. Die Messung der 
Sprachverständlichkeit eines komplet-
ten Systems, inklusive Mikrofon (Richt- 
charakteristik, Raumakustik, ... ), wird da-
durch möglich. Die NTi Audio TalkBox ist an 
der typischen Sprecherposition vor dem Mi-
krofon zu platzieren.

Der Minirator MR-PRO oder ein  
CD Spieler (mit der NTi Audio CD “STI-
PA V1.1”) oder höher kann als elektrische 
Signalquelle verwendet werden.

Achtung: Das Sprechermikrofon wird 
dabei nicht berücksichtigt.
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•	 Spielen Sie das STI-PA Testsignal ab,
•	 Stellen Sie den Schalldruckpegel auf 

den typischen Notfall-Alarmpegel ein 
(z.B. 85 dBAS).

•	 Um mit der Messung zu beginnen 
bewegen Sie den Cursor auf das START 
Feld und drücken Sie die Enter-Taste . 
Während der Messung ist kein Sprechen 
oder zusätzlicher Lärm erlaubt.

Die STI-PA Messung dauert 15 Sekunden. 
Der Fortschritt der laufenden Messung wird 
in der Balkenanzeige über dem Messstatus 
angezeigt, wobei der AL1 bereits während 
der Messung die Tendenz für das STI-PA 
Resultat anzeigt.
Nach den 15 Sekunden Messzeit wechselt 
die Statusanzeige zu FINISHED und das 
endgültige STI-PA Resultat bleibt stehen.

Die Skala reicht von BAD (schlecht) 
über PR (poor - ungenügend), FR (fair 
- akzeptabel) und GD (good - Gut) bis zu 
EXLT (Exzellent).

•	 BAD						      0.00 - 0.30 STI
•	 PR (nicht gut)			   0.30 - 0.45 STI
•	 FR (in Ordnung)		  0.45 - 0.60 STI	
•	 GD (gut)					     0.60 - 0.75 STI
•	 EXLT (exzellent)		  0.75 - 1.00 STI
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Die detaillierten Ergebnisse mit den 
individuellen Modulationsindizes und den 
Schalldruck-Pegeln sind in der zweiten 
Anzeige ablesbar. 

c. Detaillierte STI-PA Messwertanzeige

STI-PA 
Oktavbänder 

Individueller 
Oktavbandpegel

STI-PA  
Modulations-Index 2

STI-PA  
Modulations- Index 1

Fehler-
erkennung 

STI-PA Modulations-Indizes MF1, MF2
Für eine gute Sprachverständlichkeit ist ausschlaggebend wir gut 
Modulationen des gesendeten Sprachsignals erhalten bleiben. Die STI-
PA Methode basiert auf der Messung der MTF (Modulations-Transfer-
Funktion). Die einzelnen MTF Resultate geben an, wie gut die Modulationen 
in verschiedenen Frequenzbändern erhalten geblieben sind. Für jedes 
Oktavband werden 2 Modulatoren getestet (MF1 und MF2).

Weitere Informationen hierzu finden Sie im Anhang zu diesem Handbuch.
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d. STI-PA Nachbewertung

Die Messung der Sprachverständlichkeit bei realem Umgebungslärm ist 
oft nicht möglich, z.B. in öffentlichen Bahnhöfen kann keine Messung beim 
Spitzenlärmpegel morgens oder abends durchgeführt werden. Praktisch 
wird die STI-PA Messung an der Zeit durchgeführt, an der so wenig 
Menschen wie möglich durch das Testsignal gestört werden.

Für solche Spezialanwendungen kann die STI-PA Messung während 
leiser Bedingungen (z.B. beim Bahnhof in der Nacht) durchgeführt werden 
und später am Computer mit dem aktuell gemessenen Lärmspektrum 
(z.B. beim Bahnhof während des Tages) der Spitzenzeiten nachgewertet 
werden. Somit wird die zu erwartende Sprachverständlichkeit am Tage 
berechnet.

Der STI-Messbericht (Microsoft Excel Programm verbindet „geräuscharm” 
aufgenommene STI-PA Messresultate mit dem ungewichteten 
Umgebungslärmspektrum (Leq) und berechnet den zu erwartenden STI 
Wert. Die STI-PA und RTA Resultate (1/3 oder 1/1 Oktav) können mit dem 
Acoustilyzer gemessen, gespeichert und mittels MiniLINK auf den PC in 
den STI-Messbericht importiert werden. 

Der STI-Messbericht ist kostenlos zum Download für alle registrierten 
Anwender auf http://my.nti-audio.com verfügbar. Beim Öffnen des Excel 
Nachbewertungsprogramms sind alle Makros zu aktivieren.

Systemanforderungen
- PC mit Windows XP, Windows 7, 8 oder 10
- Excel 2010 - 2016 (32 Bit oder 64 Bit)
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e. STI-PA Fehlererkennung

Der Acoustilyzer überprüft automatisch im Hintergrund die Plausibilität der 
erhaltenen Einzelresultate, was für die Erkennung ungültiger Messungen 
von Nutzen ist. Konkret verifiziert der AL1 folgende Parameter:

•	 Ungültige Modulationsindizes (MF1 oder MF2 > 1.3) 
•	 Νicht konstante Bedingungen während der Messung.

Beide Parameter werden vor allem durch impulsiven Umgebungslärm 
negativ beeinflusst, was im Extremfall zu ungültigen Messresultaten führt.

Sobald während der STI-PA Messung ein 
Problem eintritt, beginnt das Resultat zu 
blinken und zeigt Fragezeichen “?.??” an.

Derartige Probleme können z.B. folgende 
Ursachen haben:
•	 Fehlendes Testsignal oder zu kleiner 

Pegel,
•	 Impulsiver Hintergrundlärm.

Detaillierte Messresultatanzeige
Diejenigen Oktavbänder, bei denen 
Messprobleme auftreten, werden mit einem 
Fragezeichen markiert.

Empfehlung
Falls die Fehlererkennung Probleme 
anzeigt, sollte die Messung wiederholt und 
mit den vorangegangenen Ergebnissen 
verglichen werden.
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f. Hinweise zur STI-PA Messung

1.	 Jeglicher Hintergrundlärm darf sich während der Messung nicht ändern. 
z.B. rosa Rauschen erfüllt diese Bedingung.

2.	 Prüfen Sie vor einer Messung die Umgebungsbedingungen, z.B. indem 
Sie eine STI-PA Messung ohne Testsignal durchführen. Das angezeigte 
Resultat sollte < 0.20 STI sein.

3.	 Während der Messung sollten keine impulsiven Hintergrundgeräusche 
auftreten. Falls dies dennoch passiert (z.B. Sprache, Gelächter, Sirenen 
etc.), kann dies zu erheblichen Messfehler führen (meistens resultiert 
dann ein höheres Ergebnis als bei einer ungestörten Messung).

4.	 Verschieben Sie wenn möglich die Messung auf eine Randzeit, z.B. in 
die Nacht. Das STI-PA Testresultat kann in danach einfach nachbewertet 
werden, indem es mit dem durchschnittlichen Oktavband-Rauschpegel 
während des Tages verrechnet wird.

5.	 Verwendeten Sie nur Qualitäts-CD-Player, deren „Shock-Protection“ Sie 
abschalten können und die nur geringe Schwankungen der 44.1 kHz 
Abtastrate (+/- 200 ppm) aufweisen. NTi Audio empfiehlt die Verwendung 
von professionellen CD Spielern.
Die Abtastrate des CD-Spielers kann wie folgt mit einem 9kHz Testsignal 
überprüft werden:

•	 Erzeuge ein 9000 Hz Sinussignal mit dem NTi Audio 
Wavefilegenerator (verfügbar zum download auf  
“www.nti-audio.com” Produkte:Acoustilyzer) und kopiere dieses 
Testsignal auf eine CD

•	 Gib diese CD in den CD Spieler und selektiere das 9 kHz Testsignal
•	 Verbinde den Acoustilyzer direkt an den Audioausgang und miss die 

Signalfrequenz im RMS/THD Modus, die angezeigte Frequenz soll 
im Bereich von 8998 bis 9002 Hz sein (die letzte stelle entspricht  
111 ppm bei 9 kHz)

6.	 STI-PA Testsignale anderer Hersteller klingen zwar ähnlich, sind jedoch 
nicht kompatibel mit dem NTi Audio Test-System. Verwenden Sie daher 
nur die original NTi Audio STI-PA Testsignal CD, Version V1.1 oder 
höher im Verbund mit dem Acoustilyzer.

7.	 Führen Sie die STI-PA Messungen von Alarmsystemen nur bei aktuellen 
Notfallbedingungen aus (d.h. komplettes Notfallsystem ist aktiviert und 
der vorgegebene Schalldruckpegel wird angewendet).
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8.	 In Umgebungen mit schwankenden Bedingungen, wie z.B. öffentliche 
Gebäude in denen sich viele oder wenige Leute aufhalten, soll das 
schlechteste STI-PA Messresultat als Referenz dienen.

9.	 Typische Messpositionen sind bei sitzendem Publikum 1 - 1.2m 
über dem Boden, bei stehendem 1.5 - 1.8m. Positionen direkt unter 
Lautsprechern sind meist nicht üblich.

10.	Die Person, die die STI-PA Messung durchführt, sollte sich nicht 
im akustischen Feld der Messung aufhalten, ansonsten kann die 
Messung beeinflusst werden. Das Messmikrofon kann z.B. auf einen 
Mikrofonständer montieret und mit einem Verlängerungskabel an den 
AL1 angeschlossen werden.

11.	Niedere STI-PA Messwerte können wie folgt verursacht werden:
•	 Starker Nachhall, Echos oder Reflektionen
•	 Schlechte Lautsprecherdirektivität oder Schallverteilung
•	 Die Einstellung der Lautsprecherleistung ist nicht o.k. (z.B. schlechter 

Signal-Rausch-Abstand)

Besuchen Sie die NTi Audio Webseite um weitere Informationen zu 
erhalten.
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Kalibrierung

Um korrekte Messergebnisse zu erhalten, muss das am AL1 angeschlos-
sene Mikrofons kalibriert werden. Der im AL1 abgelegte Default-Wert für 
die Empfindlichkeit des Mikrofons ist auf das MiniSPL abgestimmt. Beide 
Geräte zusammen, d.h. MiniSPL + Acoustilyzer bilden ein umfangreiches 
akustisches Messgerät der Klasse 2.

Alternativ lässt sich auch das M2010 Mikrofon von NTi Audio (Frequenzgang 
gemäss Klasse 1) oder ein anderes Produkt mit separater Phantom-Speisung 
verwenden.

Mikrophon- 
Sensitivität

Mikrofon-Symmetrieanzeige 
(Pfeil muss in der Mitte stehen 
→ symmetrisches Signal)

Produktions-
einstellung

Manuelle Kalibration mit 
externem Mikrophon-Kalibrator
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Der Acoustilyzer AL1 unterstützt 3 Kalibrierungsprozeduren:

a. Default-Einstellung
Verwendung eines MiniSPL Mikrofons mit 
werksseitig eingestellter Sensitivität von 
20.0 mV/Pa:
•	 Bewegen Sie den Cursor auf das Feld 

“SET TO 20.0mV/Pa” und drücken Sie 
die Enter-Taste.

b. Verwendung eines Kalibrators
Messung der Mikrofon-Sensitivität mittels 
eines externen Kalibrators:
•	 Bewegen Sie den Cursor auf die Zahl, 

welche den Schalldruck des Kalibrators 
bezeichnet und drück↑en Sie die Enter-
Taste.

•	 Stellen Sie mit Hilfe der Pfeiltasten 
den tatsächlichen Schalldruck des 
Kalibrators ein (↑ / ↓ Tasten → 
1.0 dB Schritte; ← / → Tasten → 0.1 
dB Schritte). Der AL1 unterstützt einen 
Bereich von 80 - 140 dBSPL.

•	 Drücken Sie die Enter-Taste.
•	 Stecken Sie den Kalibrator auf das 

Mikrofon, selbiges auf den AL1 und 
schalten Sie den Kalibrator ein.

•	 Drücken Sie die Enter-Taste → die 
Anzeige WORKING ... erscheint, gefolgt 
von CALIBRATION FINISHED! .

•	 Schalten Sie den externen Kalibrator 
aus und entfernen ihn.

•	 Der AL1 zeigt die neu berechnete 
Sensitivität unter USING EXT. REF.: in 
mV/Pa an.
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In folgenden Fällen erscheint eine 
Fehleranzeige auf dem AL1:
•	 Zu hoher / niedriger Eingangspegel des 

Kalibrators
•	 Errechnete Sensitivität liegt ausserhalb 

des Bereichs von 2 - 80 mV/Pa .

c. Manuelle Eingabe einer kalibrierten 
Sensitivität

•	 Wählen Sie mit dem Cursor das Feld 
„xx.x mV/Pa“ unterhalb SENSITIVITY 
an.

•	 Drücken Sie die Enter-Taste und stellen 
Sie mit den Pfeiltasten die auf dem 
Datenblatt angegebene Sensitivität 
des angeschlossenen Mikrofons ein. 
Verwenden Sie die ↑ / ↓ Tasten für 
1.0 mV/Pa Schritte und die ← / → 
Tasten für 0.1 mV/Pa Schritte. Der 
zulässige Einstellungsbereich beträgt 
2 - 80 mV/Pa.

•	 Drücken Sie nochmals die Enter-Taste 
zur Speicherung des neuen Wertes.
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5.	 MiniLINK PC Software
Die MiniLINK PC Software ermöglicht das Aufnehmen und Abspeichern 
von Acoustilyzer AL1 Messdaten auf den PC.

Installation

a.	 Anforderung: PC mit Windows XP, Windows 7, 8 oder 10 (32 Bit oder 64 
Bit)

b.	 Beiliegende MiniLINK CD in das CD-ROM Laufwerk einlegen. 
c.	 Das MiniLINK Installationsprogramm startet automatisch. Folgen Sie 

den Anweisungen auf dem Bildschirm.
	 Haben Sie auf Ihrem Rechner den CD Autostart deaktiviert, so müssen 

Sie das Installationsprogramm per Hand ausführen:
•	 Klicken Sie in der Windows Startleiste auf: “Start → Ausführen“
•	 Geben Sie „d:\setup“ ein, wobei „d“ der Laufwerksbuchstabe des 		

CD-ROM Laufwerks ist.
•	 Bestätigen Sie die Eingabe mit „ok“

d.	 Verbinden Sie das Messgerät mit den PC über das beiliegende USB 
Kabel. Windows erkennt daraufhin diese neue Hardwarekomponente 
und startet den Assistenten zur Geräteinstallation.

e.	 Die Warnmeldung “Digitale Signatur nicht gefunden” wird angezeigt. 
Bestätigen Sie diese und setzen die Installation fort.
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Starten der MiniLINK PC Software

Nach erfolgreicher Installation des Treibers kann die MiniLINK PC Software 
bei angestecktem Messgerät gestartet werden.

•	 Starten Sie MiniLINK mittels Windowsmenüpfad “Start → Programm → 
MiniLINK”. 

•	 Das Messgerät schaltet sich automatisch ein und die folgende 
Information erscheint:

•	 Versorgt durch die USB Schnittstelle schaltet sich das Messgerät 
selbst ein. Während des Betriebs über die USB Schnittstelle werden 
die Batterien nicht mehr entladen, jedoch dürfen diese auch nicht 
entfernt werden.
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Kostenlose Messgeräteregistrierung

Die neue Firmware enthält „Bonusfunktionen“, die Sie nur durch die 
Registrierung des entsprechende Gerätes freischalten können.

Übersicht der verfügbaren Bonusfunktionen:

�Messgerät Funktion Anzeige
AL1 Anpassbarer Startbildschirm

Online Registrierung:
Schliessen Sie das Messgerät an den PC an, starten die MiniLINK 
Software und folgen der automatischen Registrierungsmeldung. Alternativ 
kann die Registrierung unter dem Menüpunkt „Help → Register“ ausgeführt 
werden.

Offline Registrierung:
Alternativ registrieren Sie Ihr Gerät auf der NTi Audio Webseite  
http://registration.nti-audio.com/Registration.php mittels Eingabe Ihrer 
Kontaktdaten und der Geräteseriennummer (diese kann an der Startanzeige 
abgelesen werden). Während des Einschaltens muss eine beliebige Taste 
zur längeren Ansicht der Startanzeige gedrückt werden. Die Seriennummer 
beginnt mit drei Buchstaben (z.B. ANK675A0A2).

Nach erfolgreicher Registrierung erhalten Sie einen Schlüsselcode 
per E-mail zugesendet, den Sie im Menüpunkt „Help → Register“ 
eingeben können. Bitte beachten Sie, dass dabei das Messgerät am PC 
angeschlossen sein muss.

http://registration.nti-audio.com/Registration.php


68

Messgerätedaten auslesen

Der Speicherinhalt des ML1/DL1 wird automatisch zum PC übertragen und 
im MiniLINK Anzeigefenster graphisch dargestellt.

Achtung:	 Falls keine Messdaten gelesen werden ist der 
Messgerätespeicher leer. Klicken Sie mit der PC-Maus 
auf das „ML1 Memory“ Feld zur Aktualisierung des 
Anzeigefensters.

Die Messdatenanzeige am PC ist synchron und identisch zum 
angesteckten Minilyzer. Die Geräteseriennummer und die Firmwareversion 
des angeschlossenen Messgerätes wird in der Überschrift angezeigt. 

synchronisierte Anzeige
MiniLINK PC 

Software Version
Firmware des 

angeschlossenen 
Messgerätes

Seriennummer des 
angeschlossenen 

Messgerätes
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Visualisierung der gelesenen Messdaten

Alle im Messgerät gespeicherten Screenshots werden gleichzeitig im 
MiniLINK Anzeigefenster „ML1 Memory“ angezeigt.

 

Gespeicherte Messwerte 
mit Graphik

Gespeicherte Messwerte 
ohne Graphik

Die Pfeile weisen auf die 
zusätzlichen gespeicherten 
numerischen Messdaten mit diesem 
Screenshot hin.
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Vergrößern der Messdatenanzeige
Beim Doppelklicken auf ein Speicherbild 
wird dieses vergrößert. Das direkte Drucken, 
Speichern und Kopieren der Screenshots 
und der numerischen Testresultate wird 
hierin unterstützt.
Verfügbare numerische Messwerte werden 
immer zusätzlich unter dem Screenshot 
angezeigt.

Kopieren der Messdaten

Die angezeigten Screenshots bzw. Mess-
werte können direkt zur Dokumentation in 
Testberichte kopiert werden.

•	 Wähle das Menü „Edit → Copy Bitmap” 
zur Bildauswahl oder das Menü “Edit → 
Copy Text” zur Messdatenauswahl.

•	 Kopiere die Daten in das gewünschte 
Dokument mit „Ctrl + V”, z.B. Excel,...

Alternativ kann das mit den Messdaten 
gespeicherte „*.txt” File über den Text- 
konvertierungsassistent z.B. in Microsoft 
Excel importiert werden.
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Beispiel: Anzeige SPL/RTA Logging

Die SPL/LEQ Logging Funktion speichert die folgenden Messwerte ab 
(konform zum Loggen mit der Firmware):

•	 Messeinstellungen
•	 Zeit, relativ zum Startzeitpunkt der Aufzeichnung
•	 Alle relevanten Schallpegel Parameter
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Messdaten speichern

Die angezeigten Screenshots können als Bitmapdateien (*.bmp) und 
zusätzliche verfügbare numerische Messdaten gleichzeitig als Textfile 
(*.txt) gespeichert werden. Der Speichername besteht aus den ersten 
sechs Stellen der Messgeräte-Seriennummer und dem Screenshotnamen.

Zum Beispiel der Screenshot „A011_RT60”, abgespeichert von einem 
Acoustilyzer S/N ANK675 wird am PC gespeichert als 

•	 “ANK675_A011_RT60.bmp” & “ANK675_A011_RT60.txt”

Somit können verschiedene Messresultate von mehreren Messgeräten am 
gleichen PC abgespeichert werden.

•	 Zu speichernde Messdatenbilder im Memoryfeld auswählen

•	 Mittels PC-Maus auf SAVE bzw. im Menü File → SAVE klicken

•	 Das Speicherauswahlmenü wird angezeigt. Der Pfadname kann sich 
laut dem installierten Windows-System unterscheiden
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Während des Speichervorganges am PC können dieselben Messdaten 
auf dem Messgerät automatisch gelöscht werden. Die entsprechenden 
Einstellungen sind im angezeigten Menü auszuwählen, z.B. „Delete files in 
instrument memory after save”.

Messgerätespeicher löschen

Die am Messgerät gespeicherten Messungen können wie folgt gelöscht 
werden:

•	 Direkt im Messgerät in der Speicherübersicht

•	 Den Screenshot in der MiniLINK Anzeige wählen und mit der DEL 
Taste auf der PC Tastatur löschen

•	 Mittels Edit → Delete im MiniLINK Memory Menü

Messdatenerfassung auf dem PC

MiniLINK unterstützt zusätzlich die fortlaufende zeitliche Messdaten-
speicherung. Die aktuellen Messwerte können in beliebigen zeitlichen 
Intervallen protokolliert werden. Die geloggten Messdaten werden direkt 
in die MiniLINK Software geschrieben. Die „Save“ Funktion speichert 
die Messdaten als ASCII File auf die Festplatte. Der gespeicherte 
Datenfilename ist z.B. „ANK675_PcLog_Level SPL”. 

Die Funktion eignet sich hervorragend für Langzeitüberwachungen z.B. im 
Labor oder in rundfunktechnischen Anwendungen.

Achtung:	 Die Tickbox “Reset Leq on Start” muss für Schallpegel-
aufzeichnungen von individuellen Ereignissen angewählt 
werden. Dies setzt die Messzeituhr des Acoustilyzer beim 
Beginn des Loggen auf Null und eine neue Messung 
started automatisch.
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Symbol für direktes kopieren 
der aktuellen Anzeige

Führen Sie die folgenden Schritte aus:

•	 Gewünschte zu loggende Messfunktion wählen

•	 Die Registerkarte „Logging“ in der MiniLINK PC Software 
selektieren

•	 Gewünschtes zeitliches Loggingintervall aus Liste auswählen

•	 Startknopf drücken und die Aufzeichnung beginnt

•	 Zur Beendigung der Aufzeichnung Stop drücken

•	 Mit SAVE wird das Messergebnis abgespeichert

Zusätzlich kann der aktuelle, auf der MiniLINK PC Software angezeigte 
Screenshot, direkt in ein Dokumentationsfile kopiert werden. Mittels 
Mausklick auf das markierte Symbol wird die aktuelle Anzeige eingelesen 
und im gewünschten File mit „CTRL + V” eingefügt.
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Messgerätesteuerung über PC

Das Messgerät kann direkt per Maus oder PC Tastatur gesteuert werden. 
Klicken Sie zuerst auf das Messgerät am PC, und schon kann mittels der 
PC-Tastatur bzw. den Minilyzerpfeiltasten am PC das Messgerät über die 
USB Schnittstelle fernbedient werden.

 

Pfeiltasten + Enter

Licht: Ctrl + LESC

Ein/Aus: Ctrl + P

Klicken Sie in diese 
Bereiche um die 
Anzeige zu wechseln. 
(z.B. SPL ↔ RTA)

              

        	
•	 “Shift ←” oder “shift →” führt ein Wechsel zwischen den 

Messgeräteanzeigen einer Messfunktion durch.
 



76

MiniLINK Tools

Die MiniLINK PC Software stellt die folgenden Werkzeuge zur Verfügung

•	 LCD Fullscreen

•	 Update Firmware

•	 Crossgrade Firmware

•	 StartUp Screen
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Grossanzeige der Messresultate am PC

Die aktuelle Messgeräteanzeige kann am PC Bildschirm in voller Grösse 
dargestellt werden:

Grossanzeige herstellten
	 • Wähle das Menü “Tools → FullScreen“ in der MiniLINK Software
	 • oder klicken Sie auf das  Symbol.

Grossanzeige verlassen
	 • Die Grossanzeige wird durch einen Mausklick 
	 • oder der „Q” Taste wieder verlassen.

Symbol für 
Grossanzeige
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Firmware aktualisieren

NTi Audio stellt auf der Webseite sowohl Updates der PC-Software als auch 
der Messgerätefirmware bereit. 

Sie können den Stand Ihrer Software/Firmware wie folgt überprüfen:
•	 Verbinden Sie Ihren PC zum Web
•	 Starten Sie die MiniLINK PC Software
•	 Messgerät mittels USB Kabel zum PC verbinden
•	 Wählen Sie das Menü „Help → Look for Updates“ 
•	 Alle notwendigen Detailinstruktionen werden nun angezeigt

Alternativ können Sie die aktuellen Versionen ohne Messgerät von der 
folgenden NTi Audio Webseite herunterladen:
“http://registration.nti-audio.com/VersionCheck.php”.

•	 Wähle das Menü “Tools → Update Firmware“ 

Selektieren Sie im folgenden Fenster die Firmwareversion

für Minilyzer ML1:
ML1dA_V3.xx.bin

für Acoustilyzer:
AL1dA_A1.xx.bin

die verfügbare 
Firmware für das 
angeschlossene 
Messgerät wird 
angezeigt

Nach Bestätigung der Gerätefirmwareversion wird das angeschlossene 
Messgerät aktualisiert. Tritt während des Aktualisierens der Firmware ein 
Fehler auf (z.B. Stromausfall), so kann der Vorgang jederzeit wiederholt 
werden.

Hinweis:		 Beim Laden der neuen Firmware wird der interne 
Messgerätespeicher gelöscht. 

http://registration.nti-audio.com/VersionCheck.php
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Firmware Crossgrade

Der Acoustilyzer AL1 und der Minilyzer basieren auf der gleichen Hardware- 
Plattform mit unterschiedlicher installierter Firmware. Das verfügbare ML1 
- AL1 Crossgrade Produkt ermöglicht eine Installation der ML1 Firmware 
auf den AL1 oder eine Installation der AL1 Firmware auf den ML1.

•	 Wähle das Menü “Tools → Crossgrade Firmware“

Selektieren Sie im folgenden Fenster die Firmwareversion

für Minilyzer ML1:
AL1dA_A1.xx.bin

für Acoustilyzer:
ML1dA_V3.xx.bin

die verfügbare 
Firmware für das 
angeschlossene 
Messgerät wird 
angezeigt

Nach Bestätigung der Gerätefirmwareversion wird die entsprechende 
Crossgrade Firmware auf das angeschlossene Messgerät geladen. Das 
Messgerät zeigt dabei “UPDATING FIRMWARE” an.

Achtung:	Beim Laden der Crossgrade Firmware wird der interne 
Messgerätespeicher gelöscht, somit muss die personalisierte 
Startanzeige neu in das Messgerät geladen werden.
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Personalisieren der Startanzeige

Die MiniLINK PC Software kann ein kundenspezifisches Bild auf das 
Messgerät überspielen, das beim Einschalten des Gerätes anstatt dem 
Produkt-Logo angezeigt wird.

•	 MiniLINK PC Software starten

•	 Messgerät mittels USB Kabel zum PC verbinden

•	 Menü „Tools → StartupScreen“ wählen

Die folgende Anzeige erscheint am PC Monitor:

Im „Set Startup Screen” Feld wird die Herstellergrundeinstellung angezeigt. 
Der weisse mittlere Teil (100 x 32 Pixel) kann vom Kunden verändert 
werden. Der restliche obere und untere graue Bereich ist fixiert.
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Vorschlag für die Abspeicherung einer neuen Startanzeige:

•	 Ein vordefiniertes Bild verwenden: Die MiniLINK PC Software 
konvertiert dieses automatisch auf eine Grösse von 100x32 Pixel und 
zu einem Schwarz/Weissbild. Die folgende Formate können direkt als 
Startanzeige verwendet werden: *.pcx;*.bmp;*.dic;*.rle;*.ico;*.wmf.

•	 Ansonsten können Sie selbst ein neues Startbild in einem Bild-
bearbeitungsprogramm, z.B. MS Paint, erzeugen. Setzen Sie die 
Bildgröße auf 100x32 Pixel und füllen es mit dem gewünschten Inhalt 
(Bilder bzw. Text). Dann das neue Bild bitte als *.bmp* abspeichern.

•	 Mit „Load Image” die gewünschte neue Anzeige in die MiniLINK PC 
Software laden.

•	 Die Vorschau der neuen Startanzeige wird angezeigt.
•	 „Send to Device” wählen um die neue Startanzeige zum Messgerät zu 

senden.
•	 Das Messgerät schaltet nun automatisch aus und wieder ein. Der neue 

Startbildschirm wird angezeigt.

Beispielanzeigen:
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Aktivierung der Geräteoptionen

Das Menü “Activate Options” wird benötigt zur

•	 Aktivierung der AL1 Funktionalität am Minilyzer ML1 oder der  
ML1 Funktionalität am Acoustilyzer mit dem ML1-AL1 Crossgrade 
Produkt.

•	 Aktivierung der STI-PA Messfunktionalität am Messgerät.

Zur Aktivierung einer der oben genannten Funktionalitäten

•	 Wähle das Menü “Help → Activate Options“

•	 Das folgende Menü wird angezeigt:

Folge der Online Aktivierungsanleitung. Zusätzlich sind nochmals genaue 
Anweisungen bei der Lizenznummer jedes Produktes angefügt.
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6.	 Problemlösungen

Import von numerischen Messdatenfiles „*.txt” nach Excel
Problem: Die Zahlen werden beim Import nach Excel nur als Text erkannt, 
somit können keine Tabellen bzw. weitere Kalkulationen ausgeführt 
werden.

Lösung: Die MiniLINK Messdaten werden durch ein Leerzeichen getrennt 
und mit dem Punkt „.“ als Dezimaltrennzeichen abgespeichert. Deshalb 
muss beim Import der Daten nach Excel das Dezimaltrennzeichen auf „.” 
gesetzt werden.

Alternativ können Sie bei der vergrösserten Messdatenanzeige mittels dem 
Menüpunkt „Edit → Copy Text” die Messdaten direkt in ein offenes Excel 
Arbeitsblatt einfügen.

Rücksetzen auf Werkseinstellung
Der AL1 wird mit folgender Prozedur auf Werkseinstellungen 
zurückgesetzt:

	 •	 Gerät ausschalten
	 •	 ESC Taste und Ein/Aus Taste einige Sekunden gemeinsam drücken

Die Startanzeige mit dem Vermerk „LOADING DEFAULT SETUP“ 
erscheint.
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7.	 Zubehör

MiniSPL
Der MiniSPL ist das perfekte Zubehör für 
akustische Messungen. Zusammen mit 
dem Acoustilyzer AL1 bildet das MiniSPL 
ein umfassendes, integrierendes Schallpe-
gelmessgerät. 

Das MiniSPL ist ein omni-direktionales 1/2" 
Messmikrofon mit eingebautem Impedan-
zumformer, Vorverstärker und Versorgung. 
Es ist Batterie betrieben und weist einen 
symmetrischen Ausgang auf. Der MiniSPL 
ist klassifiziert als Typ 2 nach IEC 61672.

STI-PA Sprachverständlichkeit
Die STI-PA Option ermöglicht eine genaue 
wiederholbare Messung des Sprach-
verständlichkeitsindex während einer 
Messzeit von 15 Sekunden. Neben den 
Einzelmessresultaten STI oder CIS werden 
alle Modulationsindizes und individuellen 
Bandpegel angezeigt.

NTi Audio TalkBox
Die TalkBox ermöglicht die Messung der 
Sprachverständlichkeit bei Notfall- & Si-
cher-heitsdurchsagesystemen vom Spre-
cher bis hin zum Zuhörer. Die Verwendung 
der TalkBox vereinfacht die akustische 
Signaleinspeisung in Beschallungsanlagen 
und bietet – wie in der Sprachverständlich-
keitsnorm IEC 60268-16 gefordert - eine 
normgerechte Abstrahlung gepaart mit 
einem TNO-zertifizierten STI-PA Testsignal 
bei Normpegel.
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ML1 - AL1 Crossgrade
Das ML1 - AL1 Crossgrade ermöglicht 
das Laden der Minilyzer Firmware auf das 
Messgerät, somit sind folgende Funktiona-
litäten verfügbar:
•	 vu-PPM
•	 Symmetrie
•	 THD 2nd - 5th 

harmonische
•	 Oszilloscope

•	 Frequenz-
Sweep

•	 Zeit-Sweep
•	 Induktions-

schleifenmodus

Adapter -20dB
Der Adapter -20dB wird zur Messung von 
symmetrischen Eingangspegeln grösser als 
+20 dBu benötigt. Dieser passive Adapter 
erweitert den symmetrischen Eingangsbe-
reich des Minilyzer/Acoustilyzer auf +40 
dBu. Der Adapter wird mit einer Pin 1 Siche-
rung geliefert um eine sicheren Betrieb über 
die USB Schnittstelle zu gewährleisten.

Pouch
Die Gürteltasche schützt Ihr Minstruments-
gerät gegen Schläge, Staub und Wasser. 
Mittels des Gürtelhalters können Sie das 
Messgerät immer in Ihrer  Nähe halten 
trotzdem Sie beide Hände für andere 
Tätigkeiten benötigen.

Minstruments System Case
Geben Sie Ihre wertvollen Minstruments-
Systeme die richtige Hülle. Der in elegantem 
Grau gehaltene Minstruments-Systemkoffer 
aus schlag- und bruchfestem Polyäthylen-
Hartschaum bietet Platz für den Acoustilyzer 
AL1 oder Minilyzer ML1, Minirator MR1 und 
MiniSPL. Zusätzlich ist ein grosses Fach 
für Kabel, Stecker und anderes Zubehör 
reserviert.
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8.	 Technische Spezifikationen
Messungen

•	 Schalldruckpegel
•	 Echtzeit-Spektrumananalyse
•	 Zoom FFT
•	 Nachhallzeit
•	 Laufzeit, Delay Time
•	 Pegel RMS, Verzerrungen THD+N, Frequenz
•	 Polarität
•	 Sprachverständlichkeit STI-PA (optional)

Schalldruckpegel
	 •	 SPL, Leq, Lc peak, Lmin, Lmax laut IEC 61672
	 •	 Automatische Beendigung oder Wiederholen von Messungen 

•	 Dynamischer Bereich (mit MiniSPL): 30 - 130 dBSPLA 
•	 Filter: Flat, A, C, X-Curve-1, RLB (Lautheit im Rundfunk) 
•	 Logging von SPL/RTA Resultaten in den AL1 Speicher 
•	 Breitband- und RTA Messwerte gleichzeitig verfügbar

Echtzeit-Spektrumanalyse
	 •	 1/3 oder 1/1 Oktavbandauflösung, Klasse 0 Filter 

•	 SPL, LEQ und Max-Min Anzeige pro Band
	 •	 Logging auf PC in Intervallen von 100ms - 1 Stunde

Nachhallzeit
	 •	 1/1 Oktavbandauflösung, 63Hz - 8kHz, basierend auf T20 

•	 1/3 Oktavbandauflösung mittels Nachbewertung	
	 •	 Messung laut ISO3382 mit automatischer Mittelungsfunktion 

•	 Testsignal: getaktetes Rosa Rauschen (Test CD oder Minirator)

Zoom FFT
	 •	 Echtzeit Zoom FFT mit 50% Überlappung, 93 Bins 

•	 Frequenzbereich: 10 Hz - 20 kHz 
•	 Auflösung: 187.5 Hz to 0.73 Hz

Laufzeit, Delay
	 •	 Laufzeitmessung zwischen elektrischem Referenzsignal und 		

	 akustischen Signal über das eingebaute Mikrofon.
	 •	 Auflösung < 0.1ms, maximaler Messwert: 1 s 

•	 Testsignal: NTi Audio DelaySweep (Test CD oder Minirator)
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Polaritätstest
	 •	 Positiv / Negativ Messung mittels internem Mikrofon oder über 	

	 XLR/RCA Eingang.
	 •	 Überprüft die Polarität von Lautsprechern, Woofer und Kabel. 
	 •	 Bis zu 10 dB S/N Verhältnis des Eingangssignals.
		  •	 NTi Audio Polaritätstestsignal (AL1 Test CD oder Minirator)

Elektrische Messungen
	 •	 Pegel RMS, THD+N, Frequenz, Polarität
	 •	 Filter: Flach, A-Gewichtet, C-Gewichtet, Hochpass 400 Hz, 		

	 Hochpass 19kHz

STI-PA (Option)
	 •	 Einzelwert STI und CIS nach Standard IEC 60268-16 (2003), 

	 DIN VDE 0833-4, IEC 60849, DIN VDE 0828-1 
•	 Messung aller Modulationsindizes und individueller Bandpegel 
	 mit Fehlererkennung.  
•	 TNO verifizierte Messung 
•	 Nachbewertung mit Lärmspektrum wird unterstützt 

Frequenz
	 •	 Bereich	 10 Hz bis 20 kHz
	 •	 Auflösung	 4 digits
	 •	 Genauigkeit	 < ± 0.1 %

Pegel
	 •	 Einheiten	 dBu, dBV, VRMS
	 •	 Genauigkeit	 ± 0.5 % @ 1 kHz
	 •	 Flachheit	 ± 0.1 dB
	 •	 Bandbreite	 20 Hz bis 20 kHz
	 •	 Auflösung	 3 digits (dB-Skala) oder 4 digits (V-Skala)

THD+N (Total Harmonische Verzerrungen + Rauschen)
	 •	 Bandbreite	 10 Hz bis 20 kHz
	 •	 Auflösung	 3 digits (dB-Skala) oder 4 digits (V-Skala)
	 •	 Int. THD+N	 symmetrisch < -85 dB @ -10 dBu bis +20 dBu
			   unsymmetrisch  < -74 dB @ 0 dBu bis +14 dBu

PC Schnittstelle
	 •	 Interner Gerätespeicher für bis zu 580 Messwerte 
	 •	 USB Schnittstelle zu MiniLINK PC Software 
	 •	 Online Messdatenaufzeichnung vom Acoustilyzer an den PC
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Eingangsanschlüsse 
•	 XLR symmetrisch, RCA unsymmetrisch

Eingangswiderstand 
•	 40 kOhm symmetrisch, 20 kOhm unsymmetrisch

Eingangspegel RMS (oberes Limit)   
	 •	 symmetrisch	 +20 dBu (7.75 VRMS)
	 •	 unsymmetrisch	+14 dBu (3.8 VRMS) 

•	 für Eingangspegel > 20 dBu (symmetrisch) ist der  
	 Adapter -20 dB als Zubehör verfügbar

Max. DC Eingangspegel
	 •	 ± 50 VDC

Eigenrauschen 
•	 < 12 μV, XLR-Eingang kurz geschlossen

Internes Mikrofon 
•	 Kugelcharakteristik (zur Polaritäts- und Delay Messung)

Monitorausgang 
•	 Jack 3.5 mm (1/8“), verwendbar für Kopfhörer

Anzeige 
•	 LCD Anzeige 64 x 100 Pixel, mit Licht

Batterien 
•	 3x AA Batterien (Alkaline) 
•	 Typische Batterielebensdauer > 16 Stunden

Abmasse (L x B x H)
	 •	 163 x 86 x 42 mm (6.4“ x 3.38“ x 1.63“)

Gewicht 
•	 300 g inkl. Batterien

Temperatur 
•	 0° to +45° C

Luftfeuchtigkeit 
< 90 % R.H., nicht kondensierend
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9.	 Appendix: Einführung zu STI-PA
Anwendung
Durchsagesysteme in öffentlichen Gebäuden wie Bahnhöfen, 
Einkaufszentren oder Veranstaltungsstätten müssen im Notfall 
helfen, wichtige Informationen und Verhaltensregeln an alle 
Personen in Gefahrenbereichen weiterzugeben. Nicht- oder falsch 
verstandene Nachrichten können dabei weit reichende Folgen haben. 

Standart
Die DIN-EN 60849 schreibt deshalb für elektroakustische 
Notfallwarnsysteme eine Prüfung der Sprachverständlichkeit vor (andere 
nationale Normen siehe Tabelle). Damit soll unter realen Bedingungen 
ein Mindestmass an Sprachverständlichkeit in Gefahrensituationen 
garantiert werden. Sprachverständlichkeit ist nicht etwa eine 
subjektive Größe; es gibt mehr oder weniger aufwendigen objektiven 
Bestimmungsverfahren, die in der IEC 60268–16 genormt sind. 

Nationale Standards
•	 Elektroakustische Notfallwarnsysteme (auch VDE 0828 Teil 1 sowie 

DIN-EN, BS-EN, SN-EN, OEVE-EN, …)
•	 National Fire Alarm Code 2002 (2002 edition, section 7.4.1.4)
 •	 BS 5839-8 Fire detection and alarm systems for buildings. Code 

of practice for the design, installation and servicing of voice alarm 
systems 

Subjektive Bestimmungsverfahren
Wie das Wort Sprachverständlichkeit bereits aussagt, geht es bei deren 
Bestimmung nicht um Eigenschaften wie Frequenzgang, Verzerrungen und 
Lautstärke einer Beschallungsanlage (auch wenn diese Parameter Einfluss 
auf die Verständlichkeit haben). Vielmehr geht es darum, wie gut eine 
Nachricht tatsächlich an verschiedensten Orten verstanden werden kann. 
 
Neben messtechnischen Bestimmungen der Sprachverständlichkeit gibt 
es eine ganze Reihe statistischer Verfahren, bei denen immer ein realer 
Sprecher sowie eine möglichst repräsentative Zahl von Hörern beteiligt 
sind. Ein geschulter Sprecher liest dabei, je nach Verfahren, eine Vielzahl 
von realen oder synthetischen Worten vor und jeder Hörer notiert für 
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sich, was er glaubt, verstanden zu haben. Die Auswertung ergibt eine 
prozentuale Aussage, wie viel durchschnittlich von allen Hörern verstanden 
wurde.
Wichtige Verfahren, die nach diesem Prinzip arbeiten, heißen PB-Worte, 
CVC oder SRT (Speech Reception Threshold). Die Durchführung solcher 
Tests ist sehr aufwändig. Deshalb werden sie hauptsächlich dazu verwendet, 
messtechnische Verfahren während der Entwicklung zu überprüfen.

Messtechnische Verfahren
Bereits 1940 begannen die Bell Labors, Lösungen zur Messung von 
Sprachverständlichkeit zu entwickeln. Heute stehen mit Verfahren 
wie SII (Speech Intelligibility Index) oder verschiedenen Varianten 
von STI (Speech transmission index) Möglichkeiten zur Verfügung, 
Sprachverständlichkeit messtechnisch zu erfassen. Die Verfahren 
berücksichtigen viele für die Sprachverständlichkeit wichtige Faktoren wie: 

• Sprachpegel 
• Pegel von Hintergrundgeräuschen
• Reflektionen (Echos)
• Nachhall
• Psychoakustische Effekte (Verdeckungseffekte).

Messtechnische Verfahren verwenden synthetische Testsignale, die 
zwar nicht wie Sprache klingen, jedoch wichtige Parallelen zur realen 
Sprache aufweisen. Sowohl der durchschnittliche Frequenzgang als auch 
niederfrequente Veränderungen (Modulationen) sind der menschlichen 
Sprache nachgebildet.

Die Sprachverständlichkeitsmessung bestimmt, zu welchem Maß 
bestimmte Eigenschaften der menschlichen Stimme beim Hörer ankommen. 
Aufwendige Untersuchungen haben gezeigt, wie der Zusammenhang 
zwischen Verfälschung des Messsignals und der tatsächlichen 
Sprachverständlichkeit ist. Die Erkenntnisse dieser Untersuchungen 
steckten im Algorithmus eines Messgerätes für Sprachverständlichkeit, 
das als Ergebnis einer Messung eine Zahl zwischen 0 (unverständlich) und 
1 (exzellent verständlich) anzeigt.
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STI, RASTI oder STI-PA

STI, RASTI oder STI-PA sind die am häufigsten verwendeten Messverfahren 
zur Bestimmung der Sprachverständlichkeit. Alle drei Verfahren wenden 
im Grundsatz die gleiche Messmethode an, wobei RASTI und STI-PA 
Vereinfachungen von STI sind. Dieser Artikel zeigt, was hinter diesen 
Verfahren steckt.

Sprachmodell
Um Sprachverständlichkeit überhaupt messtechnisch erfassen zu können, 
braucht es zunächst ein Modell für Sprachsignale. Zum Beispiel lässt sich 
Sprache als Frequenzgemisch beschreiben, welches zeitlich moduliert 
(d.h. in der Amplitude verändert) wird.
Frequenzspektrum
Analysiert man den Frequenzgehalt der 
menschlichen Sprache über eine längere 
Zeit, so erhält man z.B. für einen männlichen 
Sprecher den in Abbildung1 dargestellten 
Verlauf.
 

 

 
Abb. 1: Durchschnittliches 
gemitteltes Langzeit - 
Frequenzspektrum eines 
männlichen Sprechers, in 
Oktavbänden.

Zeitliche Modulation
Innerhalb jedes Frequenzbandes treten 
beim Sprechen Pegeländerungen auf, 
d.h. jedes Frequenzband wird durch den 
Sprecher „moduliert“. Abbildung 2 zeigt 
die Hüllkurve eines Sprachsignals im 250 
Hz Band, wobei der Verlauf der Hüllkurve 
durch den Sprachinhalt geprägt ist. 
 
Durch spektrale Untersuchung längerer 
Hüllkurvensequenzen kann man 
zeigen, dass ein Sprecher die einzelnen 
Frequenzbänder mit Frequenzen 
zwischen 0.2 und 12.5 Hz moduliert. 

 
Abb. 2: Hüllkurve eines 
Sprachsignals (250Hz Band)

 
Abb. 3: Frequenzspektrum 
der Hüllkurve (250 Hz Band).
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Modulationsübertragungsfunktion (MTF)
Um eine gute Sprachverständlichkeit zu erreichen, müssen die beim 
Hörer ankommenden Modulationen möglichst gut erhalten sein. Die 
Verfahren STI, RASTI und STI-PA basieren deshalb im wesentlichen 
auf der Messung der Modulationsübertragungsfunktion (MTF, 
Modulation Transfer Function). Diese beschreibt, in welchem Masse die 
Modulationen in den verschiedenen Frequenzbändern erhalten bleiben. 

Das in Abbildung 3 gezeigte Hüllkurvenspektrum wird in einzelne 
Frequenzen im 1/3 Oktavabstand zerlegt (dies ergibt 14 Frequenzbänder 
zwischen 0.63 bis 12.5 Hz). Bei der Messung der MTF wird nun für jedes 
der 7 Sprachfrequenzbänder (siehe Abbildung 1) bestimmt, wie gut die 
einzelnen Modulationen erhalten bleiben.

Aus dem Ergebnis der MTF sowie weiteren Parametern wie 
Schalldruckpegel, Hörschwelle, Frequenzgang und psychoakustischen 
Eigenschaften (Verdeckungseffekte) lässt sich die Sprachverständlichkeit 
zuverlässig bestimmen. Die dafür notwendigen Rechenschritte basieren 
auf jahrelangen Untersuchungen und Vergleichen mit subjektiven 
Untersuchungsverfahren und werden ständig weiterentwickelt. Die 
Messung einer kompletten MTF, wie dies bei STI gemacht wird, kann 
sich sehr aufwendig gestalten. Zum Beispiel müssten im Prinzip 14 * 7 
= 98 Einzelmessungen durchgeführt werden, um eine komplette MTF zu 
bestimmen, was mindestens 15 Minuten dauern würde. Um diese Dauer 
zu verkürzen, wurden für verschiedene Anwendungsfälle Vereinfachungen 

http://www.nti-audio.com
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entwickelt, die in der Praxis eine Messung der Sprachverständlichkeit mit 
einem portablen Messgerät ermöglichen.

STI - Speech Transmission Index

Bei STI werden alle 98 Messungen zur Bestimmung der MTF durchgeführt. 
Wie bereits erwähnt, ist dies sehr aufwendig und wird daher in der Praxis 
kaum eingesetzt. STI stellt die kompletteste Art der Sprachverständlichk
eitsmessungen dar und wird vor allem dann verwendet, wenn auf Grund 
ungünstiger Bedingungen andere Verfahren nicht durchgeführt werden 
können.
In der Praxis wird STI sehr oft über die Messung der Impulsantwort (MLSA) 
mit Hilfe von PC-basierenden Systemen berechnet. Dieser Ansatz ist zwar 
sehr schnell, setzt aber einiges an Erfahrung und vor allem ein lineares 
Übertragungssystem voraus. D.h. es dürfen keine Kompressoren oder 
Begrenzer in der Übertragungsstrecke vorhanden sein, was in der Praxis 
so gut wie nie gegeben ist.

	

RASTI - Room Acoustics Speech Transmission Index

Bei RASTI werden nur wenige Abschnitte einer kompletten 
MTF gemessen. Dies stellt eine extreme Vereinfachung von STI 
dar und hat zur Folge, dass die zuverlässige Bestimmung der 
Sprachverständlichkeit mit RASTI nur unter starken Einschränkungen 
möglich ist. Eigenschaften wie Frequenzgang, Echos oder 
frequenzabhängige Nachhallzeiten werden von RASTI kaum berücksichtig. 
Lediglich zwei von einem RASTI Generator gleichzeitig ausgesendete 
Frequenzbänder werden für die Bestimmung der MFT herangezogen. Das 
500 Hz Band wird mit 4, das 2 kHz Band mit 5 Frequenzen moduliert.
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Der reale Einsatz von RASTI beschränkt sich zumeist auf die Bestimmung 
der Sprachverständlichkeit zwischen zwei Personen. RASTI war jedoch 
lange Zeit die einzige Möglichkeit, die Sprachverständlichkeit mit einem 
portablen Gerät zu messen.

STI-PA - Speech Transmission Index for Public Address Systems

Erhöhtes Sicherheits- und Qualitätsbewusstsein, neue technologische 
Möglichkeiten und die Unzulänglichkeiten von RASTI bewogen die Firma 
Bose zusammen mit dem Forschungsinstitut TNO dazu, einen neuen 
Ansatz zur Messung der Sprachverständlichkeit von Beschallungsanlagen 
zu entwickeln. Das Resultat dieser Entwicklungen ist das STI-PA Verfahren, 
welches mit wenigen Einschränkungen die einfache und zuverlässige 
Messung der Sprachverständlichkeit mit portablen Messgeräten 
ermöglicht.

Auch STI-PA verwendet ein vereinfachtes Verfahren für die Messung der 
MTF. Diese Vereinfachungen fallen jedoch massiv geringer als bei RASTI 
aus. Bei STI-PA wird die MTF aus allen 7 Frequenzbändern bestimmt. 
Die 14 Modulationsfrequenzen werden dabei auf die 7 Frequenzbänder 
aufgeteilt, so dass jedes Frequenzband mit zwei Frequenzen moduliert 
wird. Alle 7 modulierten Frequenzbänder werden von einem STI-PA 
Generator gleichzeitig wiedergegeben.

NTi Audio STI-PA Übersicht:

Tragbare STI-PA Audioanalysatoren, wie z.B. der NTi Audio Acoustilyzer, 
können die Sprachverständlichkeit während 15 Sekunden an jeder 
Position messen und sind somit hervorragend für grossflächige und rasche 
Messungen.
geeignet 

Weitere Infos sind verfügbar auf der Webseite
 „http://www.nti-audio.com, Produkte: Acoustilyzer“.

http://www.nti-audio.com
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